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Avant-propos 

Ce manuel a été créé par Hologic®, Inc. Il est destiné à guider l’utilisateur expérimenté sur la façon de configurer, d’installer et 
d’utiliser le matériel Faxitron Core et le système logiciel Vision, tous deux développés par Hologic, Inc. 

 
L’utilisateur doit d’abord configurer le matériel, puis lancer le logiciel Vision. Veuillez consulter les procédures de configuration 
requises dans la Section 4 de ce manuel avant de continuer. 

 
 
 

 
Indications d’utilisation 

 
Le système de radiographie d’échantillons numérique (DSR) Faxitron Core est un système d’imagerie radiologique 
numérique en armoire destiné à générer et à contrôler les rayons X pour l’examen de diverses régions anatomiques, ainsi qu’à 
fournir une vérification rapide que le bon tissu a été excisé pendant la biopsie percutanée. La possibilité de procéder à cette 
vérification directement dans la pièce où la biopsie est effectuée accélère le déroulement des opérations et réduit ainsi le 
temps nécessaire à l’examen du patient. La radiographie des échantillons peut potentiellement limiter le nombre de rappels 
des patients. Ce dispositif est destiné à être utilisé partout où les professionnels de la santé le jugent approprié, y compris 
dans un bloc opératoire ou une salle adjacente à un bloc opératoire. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

www.hologic.com/package-inserts 
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Ce manuel a été créé par Hologic, Inc. Il est destiné à guider l’utilisateur sur la façon de 
configurer, d’installer et d’utiliser le matériel du Faxitron Core et le logiciel Vision, tous deux 
développés par Hologic, Inc. 

 
L’utilisateur doit d’abord configurer le matériel, puis lancer le logiciel Vision. Au minimum, 
veuillez passer en revue les procédures de configuration et de sécurité requises dans ce 
manuel, avant d’essayer de faire fonctionner le système. 

 
Merci de la part de nous tous à Hologic, Inc. 

1.0.0 
Introduction 

 
Fabricant et coordonnées 

 
 

 
Hologic, Inc. 
600, Technology Drive  
Newark, DE 19702, É.-U. 
1.800.447.1856 
www.hologic.com 

 

Hologic BV 
Da Vincilaan 5 
1930 Zaventem,  
Belgique 
Tél. : +32 2 711 46 80 
Télécopie : +32 2 725 20 87 

PROMOTEUR POUR L’AUSTRALIE 
Hologic (Australia and New Zealand) Pty Ltd. 
Level 3, Suite 302 
2 Lyon Park Road 
Macquarie Park NSW 2113  
Australie 
1 800 264 073 

 

 

 
 

Les symboles suivants sont utilisés dans ce manuel et dans le système d’aide en ligne : 
 
Avertit le lecteur d’un risque d’électrocution s’il ignore l’avertissement et utilise 
délibérément des outils spécialisés pour ouvrir une armoire électrique scellée et 
manipuler son contenu.  Remarque : aucun outil n’est fourni par Hologic, Inc. 

 
Avertit le lecteur d’une situation dangereuse. Ce symbole est habituellement 
accompagné d’un symbole plus spécifique et d’instructions appropriées 
concernant la nature du danger et son issue prévisible, ainsi que d’informations 
permettant d’éviter le danger. 

 
Incite le lecteur à faire preuve de prudence lorsqu’il soulève du matériel lourd, afin 
d’éviter les blessures corporelles et les dommages matériels. 

 
Avertit le lecteur qu’un rayonnement ionisé est émis dans la zone marquée lorsque 
le faisceau de rayons X est activé. Le Faxitron Core est muni de dispositifs de 
verrouillage de sécurité pour empêcher l’accès à la zone marquée pendant que le 
faisceau de rayons X est activé. 

 
Avertit le lecteur qu’il doit utiliser une protection appropriée (telle que des gants 
chirurgicaux ou un récipient pour échantillons approuvé), afin d’éviter toute  
exposition à des matières potentiellement infectieuses, comme les échantillons de 
tissus des patients. 

1.1.0 
Symboles 
d’avertissement 
et de mise en 
garde de ce 
manuel 
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1.1.1 
Symboles 
d’avertissement et 
de mise en garde 
sur les étiquettes 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Symbole Description Norme 
 
 
 

 

Éliminez le matériel 
électronique et électrique 
séparément des déchets 
normaux. Renvoyez le matériel 
hors service à Hologic ou 
contactez votre représentant du 
service d’assistance. 

Directive 
DEEE 2012/19/UE 

 

 
Fabricant ISO 15223-1, 

Référence 5.1.1 

 

 
Date de fabrication ISO 15223-1, 

Référence 5.1.3 

 

 

Un rayonnement ionisé est émis 
lorsque le faisceau de rayons X 
est activé 

ISO 7010, 
Référence W003 

 

 

Avertissement indiquant 
d’utiliser une protection 
appropriée 

ISO 7010, 
Référence W009 

 

 

Avertissement sur l’électricité IEC 60417, 
Référence 6042 

 

 

Avertissement ISO 7010, 
Référence W001 

 

 

Consulter le mode d’emploi ISO 15223-1, 
Référence 5.4.3 

 

 

Suivre le mode d’emploi ISO 7010-M002 

 
 

 

Ce système émet de l’énergie de 
radiofréquence (RF) 
(rayonnement 
électromagnétique non 
ionisant) 

IEC 60417, 
Référence 5140 
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Symbole Description Norme 

 

 

Représentant autorisé au 
sein de la Communauté 
européenne 

ISO 15223-1, 
Référence 5.1.2 

 

 
Dispositif médical ISO 15223-1, 

Référence 5.7.7 
 

 
Numéro du catalogue ISO 15223-1, 

Référence 5.1.6 
 

 
Numéro de série ISO 15223-1, 

Référence 5.1.7 
 

 

Pays de fabrication ISO 15223-1, 
Référence 5.1.11 

 

 
Traductions en encadré Hologic 

 

 
Mise en garde ISO 15223-1, 

Référence 5.4.4 
 

 

Limites d’humidité ISO 15223-1, 
Référence 5.3.8 

 

 

Accréditation ETL Le Conseil canadien des 
normes (SCC) et 
l’Occupational Safety and 
Health Administration 
(OSHA) des États-Unis 

 

 
Utilisation sur ordonnance 
seulement 

FDA 21 CFR 801.109 

 
 

Courant alternatif IEC 60417, 
Référence 5032 

 

 
Marquage CE 
Conformité européenne 

Règlement 
MDR (UE) 2017/745 

 

 
USB, port/fiche ISO 7000-3650 

 

 

Avertissement : 
rayonnement (production 
de rayons X) 

Règlement sur les 
dispositifs émettant des 
radiations (CRC, ch. 1370) 
de Santé Canada 
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Symbole Description Norme 

 
 

Fusible IEC 60417, 
Référence 5016 

 

 

Avertissement : 
faisceau laser 

ISO 7010, 
Référence W004 

 

 

Masse (mise à la terre) IEC 60417-5017 

 

 

Faire preuve de 
prudence en soulevant 
des charges lourdes 

Hologic 

 

 
Remarque Hologic 
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Le rayonnement est une énergie sous forme d’ondes ou de particules. Le rayonnement à 
haute fréquence et à haute énergie dont l’énergie suffit à éjecter un électron de son orbite 
autour d’un noyau est appelé rayonnement ionisant. Les rayons X, les rayons gamma, les 
particules bêta, les particules alpha et les neutrons constituent tous des formes de 
rayonnement ionisant et peuvent être émis par des matières radioactives, des étoiles et des 
équipements à haute tension. 
On ne peut pas voir, ressentir, goûter, sentir ou entendre les rayonnements ionisants. Il nous 
faut donc un équipement de surveillance pour pouvoir les détecter. 

 

Rayons X 
Les rayons X sont des rayonnements à haute fréquence et à haute énergie dont l’énergie 
suffit à éjecter un électron de son orbite autour d’un noyau et que l’on appelle rayonnements 
« ionisants ». Les rayons X peuvent traverser l’air et la plupart des autres matériaux sur de 
longues distances. La quantité d’énergie acheminée par le rayonnement est directement 
proportionnelle à la fréquence et inversement proportionnelle à la longueur d’onde. Les 
rayons X ont une longueur d’onde relativement courte et une fréquence élevée, ils possèdent 
donc une grande quantité d’énergie. 
Les rayons X peuvent produire des changements biologiques dans les tissus qui peuvent être 
bénéfiques lorsqu’ils sont utilisés en radiothérapie. Toutefois, les rayons X peuvent également 
être nocifs pour les organismes biologiques en raison de leur capacité à endommager les 
chromosomes. 
Les sources de rayonnement X dans les établissements médicaux comprennent : 
Appareils de radiographie. Les appareils de radiographie sont utilisés pour le traitement 
(radiothérapie) et le diagnostic. Les appareils de radiographie diagnostiques servent à 
effectuer des radiographies sur diverses parties du corps, du thorax, de la jambe, des seins, 
etc., à des fins diagnostiques. Aujourd’hui, rien qu’aux États-Unis, la radiologie diagnostique 
représente les deux tiers de notre dose provenant de sources artificielles. Les appareils de 
radiographie peuvent produire des niveaux élevés de rayonnement ionisant. 
Appareils de radiographie en armoire. Les appareils de radiographie en armoire sont des 
chambres d’irradiation fermées, blindées et verrouillées. La machine ne peut fonctionner que 
lorsque la porte de la chambre est bien fermée. Les taux d’exposition à chaque endroit de la 
partie extérieure respectent le taux spécifié pour les zones non contrôlées. 

Sources de rayonnement 
Nous sommes tous exposés à des rayonnements, tous les jours. Selon le National Council on 
Radiation Protection (NCRP), la dose de radioactivité naturelle moyenne aux États-Unis est 
de 360 mrem/an (3,6 mSv/an). Ces expositions proviennent principalement de sources 
naturelles de rayonnement, comme le radon, le rayonnement cosmique et les dépôts naturels 
dans la terre. Même notre corps contient de la radioactivité naturelle! 
Il existe 2 sources de rayonnement : Naturelle et Artificielle. 
Les sources naturelles de rayonnement comprennent les rayons cosmiques, les rayons 
gamma terrestres, les radionucléides dans le corps, ainsi que le radon et ses descendants. La 
dose efficace annuelle moyenne mondiale provenant de sources naturelles est estimée à 
2,4 mSv (240 mrem). Certains facteurs influent sur les doses efficaces provenant de ces 
sources naturelles de rayonnement : le débit de dose des rayons cosmiques dépend de la 
hauteur au-dessus du niveau de la mer et de la latitude, le débit de dose des rayons gamma 
terrestres dépend de la géologie locale et la dose des descendants du radon dépend de la 
géologie locale, ainsi que de la construction et de l’utilisation de logements. Voir le Tableau 1 
pour connaître les doses annuelles efficaces provenant de ces sources naturelles. 

Tableau 1 
Dose annuelle efficace pour les adultes, provenant de sources naturelles 

Source d’exposition Dose efficace annuelle (mSv) 
Typique Élevée* 

Rayons cosmiques 0,39 2,0 
Rayons gamma terrestres 0,46 4,3 
Radionucléides dans l’organisme (sauf le radon) 0,23 0,6 
Le radon et ses descendants 1,3 10 

TOTAL (arrondi) 2,4 - 
*Les valeurs élevées sont représentatives des grandes régions. Des valeurs encore plus 
élevées sont présentes localement.

2.0.0 
Introduction 

 
 

 
2.1.0 
Rayons X 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2.2.0 
Sources de 
rayonnement 
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Les radiographies médicales sont une source majeure de rayonnement artificiel. Les 
radiographies médicales utilisent le rayonnement ionisant pour le diagnostic et le traitement 
de blessures et de maladies. Le Comité scientifique des Nations Unies pour l’étude des effets 
des rayonnements ionisants (UNSCEAR) estime que l’exposition individuelle aux 
rayonnements médicaux varie de 0,4 à 1 mSv par an. L’exposition à des rayonnements 
médicaux est supérieure à celle de toutes les autres sources artificielles, mais elle est 
inférieure à la moitié de l’exposition au rayonnement d’origine naturelle. 

Les doses de rayonnement ionisant utilisées dans les radiographies diagnostiques sont 
généralement assez faibles, de l’ordre de ≤ 50 KeV. 

 
 

Le tableau ci-dessous montre les contributions de diverses sources de rayonnements. 
 

 

 
L’exposition au rayonnement ionisant peut avoir des effets néfastes sur la santé en 
provoquant une altération des atomes et des molécules. Lorsque le rayonnement ionisant 
traverse les tissus, de grandes quantités d’énergie sont transférées à des molécules 
individuelles. Ce transfert d’énergie entraîne l’éjection des électrons des atomes, ce qui 
déclenche divers effets chimiques et physiques. Les dommages aux molécules d’ADN 
constituent l’élément le plus critique de ces effets. Le corps est doté de mécanismes qui 
réparent normalement ces dommages, mais des dommages importants ou certains types de 
dommages ne peuvent pas être réparés. Lorsque le corps est incapable de réparer les 
dommages, la cellule peut mourir ou muter. Les cellules mutées peuvent se transformer en 
cancers. L’étendue des dommages est proportionnelle à l’énergie transmise ou à la dose de 
rayonnement ionisant reçue. 

Les effets sur la santé de l’exposition aux rayons X sont de deux types généraux, directs ou 
indirects. On pense que les rayons X créent des radicaux dans les cellules exposées du 
corps, susceptibles de briser ou de modifier les liaisons chimiques dans les molécules 
biologiques critiques. 

2.2.0 Suite 
 
 
 
 
 
 
 
 

Figure 2.2.1 
Sources des doses de 
rayonnement aux États-Unis. 

Extrait du NCRP 160, figure 1.1. 
Pourcentage de contribution des 
diverses sources d’exposition à 
la dose efficace totale 
(1 870 000 personnes-Sv) et à la 
dose efficace totale par personne 
dans la population américaine. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2.3.0 
Effets biologiques du 
rayonnement 
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Ainsi : 

(1) les cellules peuvent être altérées ou endommagées, bien que de nombreuses cellules se 
réparent elles-mêmes, ce qui n’entraîne aucun dommage résiduel, 

(2) les cellules peuvent mourir, ce qui est le cas chaque jour pour des millions de cellules de 
l’organisme, et être remplacées, dans le cadre d’un processus biologique normal, 

(3) les cellules peuvent se réparer de façon incorrecte, ce qui entraîne un changement 
biophysique. Enfin, les rayons X peuvent traverser l’organisme sans interaction. 

 
Les dommages aux cellules causés par le rayonnement ionisant peuvent entraîner : 

• la production de radicaux libres 
• la rupture des liaisons chimiques 
• la production de nouvelles liaisons chimiques et la réticulation entre macromolécules 
• des dommages aux molécules qui régulent les processus cellulaires vitaux (p. ex., ADN, 

ARN, protéines) 
 

Le débit de dose, la dose totale reçue, l’énergie du rayonnement, la zone du corps exposée, 
la sensibilité de l’individu et la sensibilité cellulaire sont tous des facteurs qui déterminent les 
effets biologiques de l’exposition aux rayonnements. 

Il existe deux types d’effets liés à l’exposition au rayonnement ionisant : les effets déterministes 
et les effets stochastiques. 

 
 
 
 

EFFETS DÉTERMINISTES ET STOCHASTIQUES 

Les effets biologiques potentiels dépendent de la quantité administrée d’une dose de 
rayonnement et de la vitesse à laquelle cette dose est reçue. Les doses de rayonnement 
peuvent être regroupées en deux catégories : la dose aiguë et la dose chronique. 

Dose aiguë et effets déterministes 

L’exposition aiguë au rayonnement est une dose de rayonnement élevée qui se produit sur 
une courte période allant normalement de quelques secondes à quelques jours. Les effets 
causés par les doses aiguës de rayonnement sont appelés déterministes : la gravité de l’effet 
est déterminée par la quantité de dose reçue. Les effets déterministes ont habituellement un 
certain seuil sous lequel l’effet ne se produira probablement pas, mais au-dessus duquel l’effet est 
attendu. Au-dessus de ce seuil, la gravité de l’effet augmente à mesure que la dose augmente. 

Par exemple, une dose totale d’environ 300 rems (3 Sv), soit 60 fois la dose maximale 
annuelle en milieu de travail, si elle est reçue dans un court laps de temps (p. ex., quelques 
heures), provoquera des vomissements et de la diarrhée au bout de quelques heures et une 
perte de cheveux, de la fièvre et une perte de poids au bout de quelques semaines. Les 
risques de décès sans traitement médical sont d’environ 50 %. Ces effets ne se produiraient 
pas si la dose de 300 rems (3 Sv) était graduellement accumulée sur de nombreuses années. 

Il y a également une différence entre l’exposition du corps entier et l’exposition partielle du 
corps. Une dose aiguë de 600 rem (6 Sv) à la main causerait un rougissement de la peau, 
mais la récupération se ferait au cours des mois suivants et il ne devrait normalement pas y 
avoir de dommage à long terme. Cependant, une dose aiguë de cette ampleur sur 
l’organisme entier pourrait, en l’absence de traitement médical, entraîner la mort dans un 
court laps de temps. 

L’utilisation de mécanismes de radioprotection appropriés et les limites de dose d’exposition 
en milieu de travail réduisent la probabilité que ces effets se produisent. 

Les limites de dose en milieu de travail sont bien inférieures aux seuils des effets déterministes. 

2.3.0 Suite 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2.3.1 
Effets déterministes 
et stochastiques 
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Dose chronique et effets stochastiques 

Une dose chronique est une quantité relativement faible de rayonnement reçue sur une 
longue période (p. ex., plusieurs années). L’organisme est mieux équipé pour tolérer une 
dose chronique qu’une dose aiguë, puisque l’organisme a le temps de réparer les dommages 
parce qu’un pourcentage plus faible des cellules ont besoin d’être réparées à un moment 
donné. L’organisme a également le temps de remplacer les cellules mortes ou non 
fonctionnelles par de nouvelles cellules saines. Toutefois, cela ne signifie pas qu’il n’y a pas 
de risque lié à l’exposition chronique aux rayonnements. 

Le terme stochastique signifie « aléatoire », ce qui implique que de faibles niveaux 
d’exposition au rayonnement ne sont pas certains de produire un effet. Ces faibles taux, 
inférieurs au seuil des effets déterministes, peuvent, ou non, entraîner des effets néfastes 
pour l’organisme. 

Toutefois, il ne faut pas oublier que : 

1) il n’y a pas de seuil d’exposition au rayonnement en dessous duquel on peut dire avec 
certitude que les effets ne se produiront pas 

2) le doublement de la dose de rayonnement double la probabilité que des effets se 
produisent. 

L’exposition chronique peut ne produire que des effets observables un certain temps après 
l’exposition initiale. Ces effets peuvent comprendre des effets génétiques et d’autres effets 
comme le cancer, les lésions précancéreuses, les tumeurs bénignes, les cataractes, les 
changements cutanés et les anomalies congénitales. En général, la plus grande inquiétude 
est l’apparition d’une forme quelconque de cancer. 

Aucun effet immédiat n’est observé à des doses inférieures à 25 rem (0,25 Sv). Des effets latents 
peuvent apparaître plusieurs années après l’administration d’une dose. Des études menées 
auprès de populations exposées à des rayonnements ionisants (> 0,5 Sv) ont montré que la 
probabilité d’un cancer mortel résultant de l’exposition aux rayonnements est d’environ 5 % par Sv. 

 
 

RADIOSENSIBILITÉ 

La radiosensibilité est la probabilité qu’une cellule, un tissu ou un organe subisse un effet par 
dose unitaire de rayonnement. La radiosensibilité est la plus élevée dans les cellules qui se 
divisent rapidement (fortement mitotiques) ou qui sont relativement non spécialisées 
(indifférenciées). C’est pourquoi la couche basale de l’épiderme, la moelle osseuse, le 
thymus, les gonades et les cellules du cristallin présentent une forte radiosensibilité. Les 
muscles, les os et le tissu du système nerveux présentent une radiosensibilité relative faible. 
De plus, la radiosensibilité est la plus importante au stade fœtal et diminue progressivement 
pendant l’adolescence et jusqu’à l’âge adulte. 

Loi de base de la radiobiologie : Les effets biologiques sont directement proportionnels à 
l’index mitotique et au futur mitotique de la cellule exposée, et inversement proportionnels au 
degré de différenciation. La mitose fait référence à la division naturelle d’un noyau cellulaire 
pendant la reproduction cellulaire, alors que la différenciation cellulaire fait référence au degré 
de spécialisation de la cellule pour exécuter une fonction spécifique dans un organisme. 

 
 

RISQUES LIÉS À L’EXPOSITION AUX RAYONNEMENTS 

On estime qu’environ 20 % (1 sur 5) de tous les décès aux États-Unis sont dus à un certain 
type de cancer. 
Si chaque membre d’une population de 1 million devait recevoir 10 mrem (0,1 mSv) de 
radiothérapie, il est possible que l’on observe alors 5 décès supplémentaires. N’oubliez pas 
que sur cette population de 1 million de personnes, environ 200 000 mourront de cancer, 
rendant ces quelques décès supplémentaires statistiquement impossibles à détecter. 
De plus, le risque de décès par cancer est de 0,08 % par rem (10 mSv) pour les doses 
administrées rapidement (aiguës) et peut être 2 fois moins élevé (0,04 %, ou 4 sur 10 000) 
que pour les doses administrées sur une longue période (chronique). 

2.3.1 Suite 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2.3.2  
Radiosensibilité 

 
 
 
 
 
 
 
 
 
 

2.3.3  
Risques liés à 
l’exposition aux 
rayonnements 
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À partir des données actuellement disponibles, le CNRC a adopté la valeur du risque d’une 
dose en milieu de travail de 1 rem (0,01 Sv), comme représentant un risque de 4 sur 10 000 
de développer un cancer mortel. 

La Commission internationale de la protection radiologique (Publication 103, 2007) indique 
une valeur de 5,5 % par sievert pour le cancer et de 0,2 % par sievert pour les effets 
héréditaires après l’exposition au rayonnement à faible dose. 

Le risque associé aux utilisations diagnostiques du rayonnement ionisant est normalement 
limité à des effets stochastiques tardifs que l’on estime à une fréquence de peut-être 0,01 % 
pour un examen moyen (des lésions cutanées déterministes peuvent survenir après la 
radioscopie dans des cas extrêmes). Au niveau individuel, ces risques sont presque toujours 
faibles comparativement aux bienfaits du diagnostic et du traitement. 

 
 

 
CONCLUSIONS SUR LES RISQUES POUR LA SANTÉ 

Nous supposons que toute exposition aux rayonnements, peu importe son importance, 
comporte un certain risque. Cependant, nous savons qu’en moyenne, ces risques sont 
comparables ou inférieurs aux risques que nous rencontrons dans d’autres activités ou 
professions que nous considérons comme sûres. Étant donné que nous avons un contrôle 
approfondi sur l’exposition aux rayonnements que nous recevons au travail, nous contrôlons 
et minimisons ce risque. La meilleure approche consiste à maintenir notre dose à la « valeur 
la plus faible qu’il soit raisonnablement possible d’atteindre » (ALARA), un terme dont nous 
discuterons en détail plus tard. La réduction au minimum de la dose permet de réduire au 
minimum le risque. 

 
 

 
LIMITES D’ÉQUIVALENT DE DOSE DE LA CIPR 

La Commission internationale de la protection radiologique (CIPR) a établi des limites 
d’équivalent de dose de rayonnement en fonction des données disponibles. Ces limites 
d’équivalent de dose sont des valeurs maximales autorisées pour les expositions de 
l’organisme entier. L’unité de mesure de dose est appelée le Sievert (Sv) qui tient compte de 
divers facteurs pour déterminer une quantité appelée dose efficace. Les limites d’équivalent 
de dose ont été mises à jour pour la dernière fois en 2007. 

Pour les membres du public, la limite d’équivalent de dose est de 1 mSv/an (0,001 Sievert par an). 

Pour les professionnels (ceux qui travaillent dans l’industrie nucléaire), la limite d’équivalent 
de dose est de 20 mSv/an (0,02 Sievert par an). 

Les limites d’équivalent de dose excluent les effets du rayonnement d’origine naturelle. 
 
 

Limites d’équivalent de dose recommandées par la CIPR pour chaque organe ou tissu 
Dose pondérée de rayonnement dans Professionnels Public 
Le cristallin 150 mSv 15 mSv 
La peau1,2 500 mSv 50 mSv 
Les mains et les pieds 500 mSv - 

1. La limite de la dose efficace protège suffisamment la peau contre les effets stochastiques. 
Une limite supplémentaire est nécessaire pour les expositions localisées, afin de prévenir 
les réactions tissulaires. 

2. Surface cutanée moyenne de plus de 1 cm², quelle que soit la zone exposée. 

2.3.3 Suite 
 
 
 
 
 
 
 
 
 
 

2.3.4 
Conclusions sur les 
risques pour la santé 

 
 
 
 
 
 
 

2.4.0 
Limites d’équivalent 
de dose de la CIPR 
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Facteurs déterminants 

Les effets de l’exposition aux rayons X dépendent de la durée de l’exposition, de la vitesse à 
laquelle la dose est administrée, de l’énergie (la quantité d’énergie contenue dans les 
rayons X), de la dose totale (l’ampleur de la dose) et du fait que l’exposition concerne tout le 
corps ou seulement une partie localisée. Les rayons X à faible énergie (< 50 KeV) peuvent 
causer des dommages uniquement à la peau ou à la partie externe du corps, tandis que les 
rayons X à haute énergie peuvent pénétrer dans l’organisme jusqu’aux organes internes. Une 
dose aiguë importante administrée d’un seul coup aurait un effet plus important que la même 
dose administrée en fractions incrémentielles au fil du temps. 

 
Dans les environnements médicaux, le risque d’exposition aux rayonnements peut être réduit 
au minimum en : 

• évitant toute exposition inutile aux rayonnements 
• utilisant des doses dont la valeur est la plus faible qu’il soit raisonnablement possible 

d’atteindre (ALARA) 
• suivant les instructions d’utilisation des fabricants des équipements 
• suivant les instructions d’entretien préventif des fabricants des équipements 
• utilisant une protection appropriée 

 
 

 
ALARA 

Le concept de l’ALARA repose sur l’hypothèse selon laquelle toute dose de rayonnement, 
même infime, peut avoir un effet indésirable. En vertu de l’ALARA, tous les moyens 
raisonnables de réduire l’exposition sont utilisés. 

Il existe trois règles générales pour réduire l’exposition d’une personne à tout type de 
rayonnement ionisant. 

1. Réduire le temps d’exposition à la source de rayonnement. 
• La réduction du temps d’exposition réduit la dose de rayonnement. 

2. Augmenter la distance entre la personne et la source de rayonnement. 
• L’augmentation de la distance par rapport à une source de rayonnement réduit 

considérablement la dose de rayonnement. 
• Le fait de doubler la distance par rapport à une source de rayonnement permet 

de diviser par quatre le débit de dose. 
• Le fait de tripler la distance permet de diviser le débit par neuf. 

3. Augmenter la protection entre la personne et la source de rayonnement. 
• L’utilisation d’une protection appropriée réduit considérablement la dose. 
• Le matériau utilisé et l’épaisseur de la protection dépendent de la source du 

rayonnement. 
• Le plomb est un matériau de protection courant. 

 
Consultez votre agent de radioprotection pour connaître les règles et les lignes directrices 
propres à votre établissement. 

2.5.0 
Gestion des risques 
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Le système de radiographie d’échantillons numérique (DSR) Faxitron Core est un 
système de radiographie numérique en armoire de bureau compact destiné à permettre une 
vérification rapide des biopsies au trocart. 

La possibilité de procéder à cette vérification directement dans la pièce où la biopsie est 
effectuée accélère le déroulement des opérations et réduit ainsi le temps nécessaire à 
l’examen du patient. La radiographie des échantillons peut potentiellement limiter le nombre 
de rappels des patients. La petite taille du Faxitron Core permet de l’installer dans les blocs 
opératoires ou les bureaux où l’espace est restreint. 

 
Le système de radiographie d’échantillons numérique Faxitron Core utilise Vision, un 
logiciel complet et puissant d’acquisition d’images et de manipulation de données. Le logiciel 
Vision gère l’acquisition numérique d’images radiographiques, l’étalonnage, l’affichage 
d’images, l’analyse et la manipulation d’images, la base de données de patients, l’archivage 
d’images et la transmission. Le logiciel Vision est la partie centrale de ce système. Le logiciel 
Vision est conforme à la norme DICOM (Digital Imaging and Communications in 
Medicine) 3.0 et est fourni avec la liste de travail des modalités DICOM (MWL). 

 
 

Version DICOM 
 

Hologic utilise la norme DICOM la plus récente : 
ACR-NEMA Digital Imaging and Communications in Medicine (DICOM) v3.0, version finale, 
août 1993. 

 
Hologic est conforme aux normes suivantes : 
NEMA PS 3.1 - 3.20 (2016), Digital Imaging and Communications in Medicine Set 

 
Classes de stockage 

 
Faxitron DR procure une conformité standard à la classe de parité objet/service (SOP) 
DICOM V3.0 suivante en tant qu’utilisateur (Service Class User ou SCU). 

 
Classe de Parité objet/service (SOP) du SCU 

 
Classe de Parité objet/service (SOP) ID unique de la classe de SOP 

SOP de stockage des images radiographiques 
numérisées 

1.2.840.10008.5.1.4.1.1.1 

Présentation du stockage des images 
radiographiques numérisées 

1.2.840.10008.5.1.4.1.1.1.1 

Traitement du stockage des images 
radiographiques numérisées 

1.2.840.10008.5.1.4.1.1.1.1.1 

Présentation du stockage des images de 
mammographie numérisées 

1.2.840.10008.5.1.4.1.1.1.2 

Traitement du stockage des images de 
mammographie numérisées 

1.2.840.10008.5.1.4.1.1.1.2.1 

Informations sur la requête/récupération de la 
racine de l’étude. Modèle -FIND 

1.2.840.10008.5.1.4.1.2.2.1 

Informations sur la requête/récupération de la 
racine du patient. Modèle -FIND 

1.2.840.10008.5.1.4.1.2.1.1 

Informations sur la liste de travail de modalité 
Modèle - FIND 

1.2.840.10008.5.1.4.31 

Stockage de la version électronique de l’échelle de 
gris 

1.2.840.10008.5.1.4.1.1.11.1 

 
Pour obtenir plus d’informations, consultez la déclaration de conformité DICOM complète 
enregistrée sur le système. Le fichier se trouve sous C:\Faxitron et un raccourci est fourni sur 
le bureau. 

Si nécessaire, une copie de la déclaration de conformité DICOM est disponible sur demande 
auprès de Hologic. 

3.0.0 
Présentation 

 
 
 
 
 
 
 
 
 

 
 

3.0.1 
Version DICOM 
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Entretien 

 
L’équipement Hologic ne contient aucune pièce pouvant faire l’objet d’un entretien. Veuillez 
contacter votre représentant Hologic agréé pour toute tâche d’entretien. 

 
États-Unis : +1 877 371.4372 

Europe : +32 2 711 4690 

Asie : +852 37487700 

Australie : +1 800 264 073 

Tous les autres pays : +1 781 999 7750 
Adresse courriel : BreastHealth.Support@hologic.com 

 

 
Dépannage 

 
Consultez le manuel d’entretien de Faxitron Core, communiquez avec votre représentant 
Hologic ou avec le service à la clientèle Hologic. 

 
 

CALENDRIER DE MAINTENANCE 
 

Consultez le manuel d’entretien de Faxitron Core, communiquez avec votre représentant 
Hologic ou avec le service à la clientèle Hologic. 

3.0.2 
Entretien et 
dépannage 

 
 
 
 
 
 
 
 
 
 

 
3.0.3 
Calendrier de 
maintenance 
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Caractéristiques 
techniques 

 
Figure 3.0.1 
Dimensions et poids 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
DISTANCES SOURCE-IMAGEUR (SID) et SOURCE-OBJET (SOD) : 

• Du haut de la caméra à l’imageur : 0,230 po (5,8 mm) 
• Cible du tube à l’imageur :  12,90 po (327,66 mm) 
• Cible du tube à la position de l’échantillon : 8,94 po (227,08 mm) 
• Imageur à la position de l’échantillon : 3,96 po (100,58 mm) 
• Grossissement efficace :  1,44:1 

POIDS : 40 lb (18 kg) 
 

ALIMENTATION REQUISE : 120 V CA 60 Hz 150 W max. ou 230 V CA 50 Hz 150 W max. 
 

PRODUCTION DE CHALEUR : 500 BTU/h max. 
 

CYCLE D’UTILISATION DES RAYONS X : 50 % 
 

CONTRÔLE DE L’EXPOSITION : Automatique ou manuel 
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Exigences | Conformité du Faxitron Core 

Il incombe à l’établissement ou à l’institution qui exploite ce système de veiller à ce que toutes 
les réglementations locales, régionales et fédérales affectant l’utilisation de l’équipement de 
rayonnement ionisant soient respectées. 

 
 

Limites d’émission 

Le rayonnement des rayons X émis par l’unité Faxitron Core ne dépasse pas une exposition 
de 0,3 milliroentgen (mR) par heure en un point quelconque situé à 5 centimètres (cm) à 
l’extérieur de la surface externe. Pour les pays exigeant des valeurs d’émission mesurées à 
10 cm des surfaces externes, le rayonnement ne dépasse pas 0,1 mR par heure à 10 cm. 

 
 

Dispositifs de verrouillage de sécurité 

Le système de radiographie d’échantillons numérique (DSR) Faxitron Core est doté de deux 
dispositifs de verrouillage de sécurité sur le tiroir à échantillons, le panneau d’accès avant et 
le couvercle arrière, pour prévenir la production de rayons X si ces éléments ne sont pas 
fermés ou installés. 

 
Bouton de démarrage 

Après l’interruption de la génération de rayons X par les dispositifs de verrouillage de sécurité, 
l’activation du bouton « Start » (Démarrage) du panneau avant permettra la reprise de la 
génération de rayons X lorsque le système sera prêt. 

 
Commande par clé 

Un interrupteur à clé situé sur le panneau avant et qui nécessite l’insertion d’une clé et sa 
rotation dans le sens des aiguilles d’une montre jusqu’à la position de « 3 heures », pour 
permettre la mise sous tension du système de l’armoire. La clé ne peut pas être retirée en 
position « MARCHE ». 

 
Bouton d’arrêt d’urgence 

Le bouton d’arrêt d’urgence situé sur le panneau avant du Faxitron Core permet d’interrompre 
la génération de rayons X. Cette mesure s’ajoute aux dispositifs de verrouillage de sécurité du 
tiroir du système. 

 
Voyants de génération de rayons X 

Le Faxitron Core est muni d’un voyant lumineux d’activation de rayons X sur le panneau avant 
et sur l’interface graphique de l’utilisateur. Il émet également un signal sonore pendant la 
génération de rayons X. 

 
Accès au logiciel – Mot de passe facultatif 

L’utilisateur a la possibilité d’établir un mot de passe obligatoire pour ouvrir le logiciel Vision. 
Lorsque cette option activée, le bon « mot de passe défini par l’utilisateur » doit être saisi pour 
permettre l’ouverture du logiciel Vision. Si le mot de passe saisi est incorrect, le logiciel se 
ferme. 

 

 
Système de commande des rayons X 

Le système de commande des rayons X comprend l’électronique du système, les interrupteurs 
de verrouillage, le bouton d’activation de radiographie, le bouton d’arrêt d’urgence et le logiciel 
d’imagerie du système (Vision). 

Le système Faxitron Core dépend entièrement du logiciel pour l’acquisition d’images/la 
génération de rayons X. 

3.2.0 
Exigences de 
conformité et 
mesures de sécurité 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.3.0 
Système de 
commande des 
rayons X 
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Le logiciel et le micrologiciel de la carte contrôleur surveillent les conditions du système pour 
déterminer : 

1) si l’acquisition d’images est autorisée 
2) les paramètres d’acquisition (niveau d’énergie et durée) 
3) si l’acquisition d’images doit être interrompue 
4) quels messages doivent être affichés, le cas échéant 
5) les indicateurs appropriés à activer. 

 
La condition suivante doit être présente pour que l’acquisition d’images/la génération de 
rayons X se produise : 

1) le logiciel Vision doit être ouvert 
2) le système doit être armé – les données du patient doivent être saisies 
3) les interrupteurs de verrouillage doivent être fermés 
4) la carte contrôleur doit communiquer avec le logiciel du système (Vision) 
5) le dispositif d’imagerie numérique doit communiquer avec le logiciel du système 
6) le bouton d’activation des rayons X doit être enfoncé. 

 
Si les conditions ci-dessus sont remplies : Le logiciel détermine les paramètres d’acquisition 
d’image (niveau d’énergie et durée) et le logiciel envoie ces paramètres à la carte contrôleur. 
Le contrôleur traite le signal et l’achemine au bloc d’alimentation en haute tension. Si le circuit 
haute tension est actif, le bloc d’alimentation en haute tension génère une haute tension qui 
est envoyée au tube radiogène. Des rayons X sont alors générés. Des indicateurs et des 
messages sont activés pour informer l’utilisateur que l’acquisition d’images/génération de 
rayons X est en cours. 

Si, à tout moment pendant l’acquisition d’images, un verrou est ouvert, l’acquisition 
s’interrompt et les indications et messages appropriés s’affichent. 

 
 

Protection 
Le système Faxitron Core est conçu pour générer des énergies de rayonnement ionisant à 
30 keV ou moins. 
L’acier inoxydable utilisé par le fabricant du compartiment à rayons X du Faxitron Core est un 
matériau à haute impédance électrique qui absorbe efficacement près de 100 % du 
rayonnement ionisant à ce niveau d’énergie. 
Aucune protection supplémentaire n’est requise. 

 
Atténuation 
Le faisceau primaire du tube radiogène du Faxitron Core est dirigé vers le plancher du 
système. Les faisceaux réfléchis ou dispersés sont absorbés par le haut du compartiment à 
rayons X, les parois et l’avant du tiroir. 
Les mesures typiques des rayonnements d’origine naturelle à l’usine de fabrication Hologic 
sont de 0,1 µSv/h (0,01 mR/h). 
Les mesures de dose sont prises à des niveaux d’énergie de 30 keV avec un bloc acrylique 
de 6 mm dans la trajectoire du faisceau primaire, pour représenter les niveaux d’énergie 
maximum du système et la diffusion maximale du faisceau. Les mesures à des surfaces 
accessibles se situent généralement entre 0,1 et 0,5 µSv/h (0,01 et 0,05 mR/h). 

 
 

Hologic recommande de respecter la valeur la plus faible qu’il soit raisonnablement possible 
d’atteindre (ALARA). Utilisez des niveaux d’énergie ne dépassant pas ce qui est nécessaire 
pour effectuer la tâche. L’utilisation du contrôle automatique de l’exposition (AEC) garantit que 
les niveaux d’énergie de rayonnement ionisant les plus bas possibles sont générés pour 
obtenir une qualité d’image optimale. Lorsque l’AEC est activé, le système exécute une courte 
exposition d’échantillon à un niveau d’énergie et selon une durée prédéterminés. Le logiciel 
évalue l’image de l’échantillon et calcule les meilleurs paramètres d’énergie et de temps. 

3.3.0 Suite 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.4.0 
Protection et 
atténuation 

 
 
 
 
 
 
 
 
 
 
 
 
 

3.5.0 
ALARA 
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EXIGENCES RÉGLEMENTAIRES 

Il incombe à l’établissement ou à l’institution qui exploite ce système de veiller à ce que toutes 
les réglementations locales, régionales et fédérales affectant l’utilisation de l’équipement de 
rayonnement ionisant soient respectées. 

 
 

Avertissements 

• Veuillez lire attentivement les instructions avant d’utiliser le système. 

• N’utilisez pas le système d’une manière autre que l’utilisation prévue, telle que décrite dans 
ce manuel. En cas de doute, veuillez contacter Hologic ou votre distributeur autorisé. 

• Les cordons d’alimentation n’ont pas tous la même puissance. N’utilisez pas un autre 
cordon d’alimentation avec ce système que celui fourni. N’utilisez pas le cordon 
d’alimentation de ce système sur un autre équipement. 

• Ce système a été testé selon les normes internationales les plus strictes. Toutefois, il est 
recommandé de contacter les autorités nationales pour connaître les exigences 
opérationnelles locales. 

• Ce système n’est pas destiné à une utilisation publique. Il doit être situé dans une zone où 
le grand public ne peut pas accéder au système sans la présence d’un opérateur. 

• L’utilisation de commandes ou de réglages pour effectuer des procédures autres que celles 
spécifiées dans le présent document peut entraîner une exposition dangereuse au 
rayonnement. 

 
 

Précautions générales 

Les précautions suivantes doivent être prises pour éviter d’endommager votre système 
Faxitron Core : 

• Ne branchez ou ne débranchez jamais les câbles de communication et/ou d’alimentation 
lorsque le système de la caméra est sous tension. Des dommages au capteur CMOS ou 
aux composants électroniques de la caméra peuvent survenir si les câbles sont 
branchés/débranchés pendant que l’unité est sous tension. 

• Le système de caméra est fragile et il faut prendre des précautions pour ne pas 
l’endommager. Le système de la caméra ne doit jamais être maltraité, heurté, cogné ou 
échappé. 

• Le système Faxitron Core dispose d’un mode d’étalonnage. L’étalonnage doit être effectué 
quotidiennement pour assurer le bon fonctionnement du système. Reportez-vous aux 
sections 5 et 6 de ce manuel pour connaître la procédure d’étalonnage. 

• Assurez-vous que le tiroir à échantillons est complètement fermé avant d’éteindre l’appareil. 

• Assurez-vous que le tiroir à échantillons est propre et exempt d’échantillons ou de résidus 
avant d’éteindre l’appareil. 

4.0.0 
Avertissements 
et précautions 
relatifs au 
système 
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Connexions interopérables 
Le Faxitron Core peut fonctionner comme un dispositif autonome sans aucune entrée ou 
sortie vers d’autres dispositifs. Les images peuvent être capturées, stockées et examinées 
directement sur le système. 
Toutefois, le système est livré avec plusieurs interfaces. L’interface principale est la 
connexion réseau qui permet au système d’être connecté à un système d’archivage et de 
transmission des images (PACS, Picture Archiving and Communication System). Ensuite, les 
images peuvent être transmises en format DICOM directement du dispositif au réseau de 
l’établissement, à l’aide de notre logiciel. Consultez la section 6 pour obtenir plus de détails 
sur la version DICOM. Seuls des employés de Hologic ou le personnel informatique qualifié 
de l’établissement de l’utilisateur doivent configurer cette communication. 
Les connexions du système et leur utilisation prévue sont indiquées ci-dessous. Aucun autre 
type de dispositif ne doit être branché au système Faxitron Core sans l’approbation de Hologic. 

4.0.0 Suite 

 

Raccordement Usage Type de dispositif Utilisateur prévu 

Port Ethernet à 
l’arrière 

Pour stocker des images radiographiques 
sur un réseau de stockage de données 

PACS ou réseau de 
stockage 

Configuré par le personnel de Hologic ou du 
service informatique de l’établissement. 
Utilisé par les cliniciens. 

Port Ethernet à 
l’arrière 

Pour permettre la connexion à distance par 
l’équipe de service d’assistance Hologic, 
afin que Hologic puisse diagnostiquer et 
réparer le système. 

Connexion 
Internet en 
réseau 

Personnel de Hologic ou du service 
informatique de l’établissement 

Port USB à 
l’avant 

Pour transférer des images à partir du 
dispositif. Cette option doit être utilisée 
uniquement si le PACS ou le réseau 
n’est pas disponible. 

Périphérique de 
stockage USB (clé 
USB) 

Cliniciens ou personnel du service 
informatique disposant d’un accès autorisé 
au système. 

Port USB à 
l’avant 

Pour entretenir et maintenir le système, il 
peut être nécessaire de copier des fichiers 
vers et depuis l’ordinateur. Par exemple, 
les mises à jour logicielles ou les fichiers 
journaux. 

Périphérique de 
stockage USB (clé 
USB) 

Personnel de Hologic ou du service 
informatique de l’établissement 

Port USB à 
l’arrière 

Pour permettre la connexion d’une 
imprimante. Le logiciel Vision permet de 
connecter une imprimante DICOM ou 
une imprimante standard compatible 
Windows. 

Imprimante DICOM 
ou Windows 

Cliniciens ou personnel du service 
informatique de l’établissement 

 
Cybersécurité 

La sécurité du dispositif est une responsabilité partagée entre Hologic et les établissements 
de soins de santé. Le fait de ne pas assurer la cybersécurité peut entraîner une détérioration 
des fonctionnalités du dispositif, la perte de disponibilité ou d’intégrité des données 
(médicales ou personnelles) ou l’exposition d’autres dispositifs ou réseaux connectés à des 
menaces de sécurité. Hologic effectue un ensemble de contrôles de cybersécurité pour 
assurer la cybersécurité de ses unités et maintenir leur fonctionnalité et leur sécurité. 

Toutes nos unités utilisent des systèmes d’exploitation standard Windows. Lors de 
l’installation, nous recommandons à l’établissement de mettre en place toutes les mesures de 
sécurité nécessaires définies par leurs propres exigences internes, comme ils le feraient avec 
tout autre ordinateur connecté au réseau. 

L’établissement peut configurer le système d’exploitation Windows avec tous les protocoles 
de réseau et toutes les autorisations nécessaires. Par exemple, il peut ajouter : 

• des identifiants d’utilisateur et des mots de passe, 
• des autorisations par couches avec une authentification appropriée, 
• des restrictions sur les installations de logiciels, 
• des exigences relatives au contenu de confiance, y compris la vérification de la signature du code, 
• la configuration des mises à jour de Windows, y compris les versions de sécurité. 
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De plus, notre logiciel d’imagerie (Vision) peut être protégé par mot de passe, afin que certains 
utilisateurs puissent accéder au système d’exploitation sans pouvoir ouvrir le logiciel Vision. 

L’unité est livrée avec une clé physique qui permet la mise sous tension du système de 
radiographie. Cela permet de verrouiller le système, de sorte que même si l’on accède au 
logiciel, aucune radiographie ne peut être lancée. 

Cette unité est conçue pour être utilisée comme unité autonome ou connectée au PACS 
interne de l’établissement ou à un autre réseau en boucle fermée. Elle n’est pas destinée à 
être connectée à l’Internet, à moins que (a) l’établissement reçoive des instructions spécifiques 
dans ce sens de la part de Hologic, ou que (b) l’établissement prenne des précautions adéquates 
pour assurer sa cybersécurité face aux menaces liées à sa connexion à l’Internet. 

Hologic développera des mises à jour ou des correctifs pour le logiciel Hologic, afin de continuer à 
assurer la sécurité du produit, selon les besoins, tout au long du cycle de vie de l’unité. 

Des mesures de sécurité supplémentaires, y compris le cryptage, peuvent être mises en 
œuvre et Hologic peut travailler avec le service informatique de l’établissement, afin de 
réduire les risques pour les patients en cas de violation de la cybersécurité. 

 
Événements liés à la cybersécurité 

Si un événement lié à la cybersécurité se produit, déconnectez le système du réseau et 
contactez immédiatement Hologic. Nous travaillerons avec votre service informatique pour 
résoudre le problème. 

Un événement lié à la cybersécurité peut être détecté de plusieurs façons : 

• Fonctionnement et/ou connexion réseau plus lents que la normale, 
• Fenêtres contextuelles suspectes ou page d’accueil modifiée dans le navigateur Internet, 
• Mot(s) de passe inopérant(s), 
• Programmes non identifiés dans le menu de démarrage ou dans la barre d’état du 

système, 
• Données manquantes, corrompues ou altérées. 

 

 
Nettoyage 
Surfaces internes du compartiment 

Les échantillons biologiques peuvent contenir des agents infectieux dangereux pour votre 
santé. Veuillez suivre les procédures de biosécurité appropriées : porter des gants lors de la 
manipulation des échantillons de tissus ou de tout matériel avec lequel ils sont entrés en contact. 

La seule partie du compartiment à rayons X accessible pour le nettoyage est le tiroir à 
échantillons. Vous pouvez essuyer doucement le tiroir à échantillons avec un chiffon doux 
non pelucheux humecté d’alcool isopropylique 70-90 % ou d’hypochlorite de sodium dilué  
(5-25 % - 6,15 % de javellisant domestique dilué à 1:500 fournit la bonne concentration). 

• N’utilisez pas d’abrasifs ou de solvants agressifs. 
• Ne frottez pas la zone d’imagerie encastrée du tiroir, car cela pourrait rayer la 

surface et créer des artefacts d’image. 
• Testez les produits de nettoyage sur une petite zone non visible du tiroir, pour 

vérifier qu’ils n’endommagent pas le matériau. 
 

Externe 

Essuyez régulièrement les surfaces externes avec de l’alcool isopropylique, de l’hypochlorite 
de sodium ou un savon doux et de l’eau (concentrations appropriées indiquées ci-dessus). Ne 
trempez pas ou n’inondez pas les surfaces et n’utilisez pas d’abrasifs qui pourraient rayer les 
surfaces. Ne laissez pas l’humidité entrer en contact avec les composants électriques du 
système. Testez les produits de nettoyage sur une petite zone non visible des capots, pour 
vérifier qu’ils n’endommagent pas le matériau. 

4.0.0 Suite 
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Installation du système 

Le système Faxitron Core doit être configuré par un représentant autorisé de Hologic, Inc. 

 
Inspection des boîtes 

Le système Faxitron Core est livré dans une (1) boîte de carton. La boîte contient l’armoire de 
radiographie Faxitron Core, l’ordinateur, le moniteur, le cordon d’alimentation, le câble vidéo, 
les câbles, les cordons, la documentation, les clés de l’armoire de radiographie et 25 plateaux 
d’échantillons. 

Demandez à l’agent de transport de déposer la boîte dans une zone à l’abri du vol, des 
dommages et des conditions environnementales extrêmes, jusqu’à ce que le représentant 
autorisé de Hologic, Inc. puisse installer le système. 

Vérifiez la boîte pour voir s’il y a des dommages. En cas de dommages, communiquez avec 
Hologic au 1-800-447-1856. 

 
 

Levage et transport des boîtes 

Mise en garde : la boîte pèse environ 80 livres (36,3 kg). La boîte doit être placée à la 
verticale, comme indiqué sur les étiquettes. Faites preuve de prudence au 
moment de la déplacer, pour éviter les blessures et les dommages au 
système. 

 
 

Déballage et assemblage du système 
Le système Faxitron Core doit être déballé et assemblé sur place par un représentant 
autorisé de Hologic, Inc. 

 
 

Emplacement 

Laissez un espace libre d’au moins 6 po (15 cm) derrière l’armoire lorsqu’elle est installée, 
pour permettre une ventilation adéquate et un accès au cordon d’alimentation et aux câbles. 

 
 

Conditions environnementales 
En fonctionnement : 

4.1.0 
Configuration 
du système de 
radiographie 
d’échantillons 
Faxitron Core 

 
 
 
 
 
 
 
 
 
 

Température :  15,5 à 30 degrés C ou 60 à 86 degrés F.  

Humidité relative : < 75 pour cent. 

Stockage et transport : 

Température : -20 à 50 degrés C ou -4 à 122 degrés F. 

Humidité relative : < 75 pour cent. 

Cet équipement a été conçu pour les conditions suivantes : 

• Utilisation intérieure, 
• Altitude jusqu’à 2 000 mètres (6 562 pieds), 
• Degré de pollution 2, 
• Surtension de catégorie II 
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ALIMENTATION REQUISE : 120 V CA 60 Hz 150 W max. OU 240 V CA 50 Hz 150 W max. 

PRODUCTION DE CHALEUR : 500 BTU/h max. 

CYCLE D’UTILISATION DES RAYONS X : 50 % 

RADIOPROTECTION : reportez-vous à la section 2 de ce manuel. 
 
 

Le Faxitron Core a été conçu comme une unité fixe devant être installée sur un bureau, un 
comptoir ou une table. 

Déplacement du système Faxitron Core – Non recommandé. 
Une fois installé à son emplacement final, il est recommandé de ne pas déplacer le 
système Faxitron Core. 

Le système Faxitron Core n’est pas conçu pour être portatif. Actuellement, aucun chariot n’est 
fourni. Il faut donc également installer le système informatique sur une surface non portative. 

 
 

Mise en garde : l’armoire de radiographie Faxitron Core pèse environ 40 lb (18 kg) et n’est 
pas conçue pour être soulevée et transportée. Il s’agit d’un instrument de 
précision qui doit être manipulé de façon appropriée. N’essayez pas de 
soulever ou de transporter le système. 

Veuillez ne pas bloquer la zone située derrière ou immédiatement devant l’unité, car cet 
espace ouvert est nécessaire pour la ventilation du système et de l’ordinateur. Il y a une 
ventilation adéquate à l’arrière du système, dans la mesure où aucun objet n’est placé entre 
l’unité et le mur qui contient la prise de courant du système. 

Assurez-vous que la surface devant le système soit plane, de niveau et exempte de dangers, 
afin de permettre au personnel d’accéder en toute sécurité à la porte des échantillons, au 
clavier de l’ordinateur, au moniteur et au panneau de commande du système. 

4.1.0 Suite 
 
 
 
 

4.2.0 
Déplacement du 
système de 
radiographie 
d’échantillons 
Faxitron Core 

 
 
 

 
 

 Remarque : laissez suffisamment d’espace à côté du système pour accéder facilement au cordon d’alimentation du système. 
 
 

Mise en garde : si vous devez déplacer le système Faxitron Core : 
• assurez-vous que tous les composants sont hors tension 
• débranchez les cordons d’alimentation de la prise de courant 
• débranchez tous les cordons et câbles d’interconnexion  

(p. ex., câble à fibre optique). 
• faites preuve de prudence lorsque vous déplacez l’armoire de  

radiographie Faxitron Core. 

 
Avertissement : le cordon d’alimentation du système Faxitron Core est fourni avec une 

fiche mise à la terre. S’il n’y a pas de prise appropriée correspondant à la 
fiche du cordon d’alimentation du système, faites appel aux services d’un 
technicien qualifié pour installer une prise électrique appropriée. N’essayez 
pas de modifier vous-même la fiche ou la prise de courant. 

 
Avertissement : pour éviter d’endommager l’unité et/ou le contact avec des tissus infectieux, 

assurez-vous que le Faxitron Core est bien nettoyé et emballé avant de le 
mettre hors service à des fins d’entretien, de transport ou d’élimination. 
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Avant de mettre le système sous tension, assurez-vous que les cordons d’alimentation sont 
bien branchés dans l’armoire, l’ordinateur et le moniteur Faxitron Core, avant de brancher les 
cordons dans les prises d’alimentation principales de l’établissement. De plus, si nécessaire, 
branchez un câble réseau Cat5 ou Cat6 dans l’ordinateur Faxitron Core et la connexion 
réseau de l’établissement. 

Consultez la section 4 Installation et configuration de ce manuel, ainsi que les guides 
d’installation et de démarrage rapide fournis avec votre système Faxitron Core. 

Procédures d’imagerie de base 
 

Avertissement : l’utilisation du Faxitron Core d’une manière autre que celle décrite dans ce 
manuel peut entraîner un mauvais fonctionnement de l’équipement ou 
causer des blessures corporelles. 

Avertissement : utilisez des récipients ou des gants approuvés, afin d’éviter tout contact avec 
des échantillons de tissus de patients potentiellement dangereux. 

 
Résumé de la séquence d’imagerie 

 
Reportez-vous au guide de démarrage rapide Faxitron Core pour obtenir un résumé du 
fonctionnement du système. 
• Ouvrez le tiroir à échantillons (appuyez sur le bouton noir). 
• Placez le(s) échantillon(s) dans un récipient pour échantillon fourni par Hologic, Inc. ou par 

votre établissement et déposez le récipient à l’intérieur du tiroir du Faxitron Core. 
• Fermez le tiroir à échantillons (appuyez sur le bouton noir). 
• Sélectionnez ou saisissez un patient dans le logiciel Vision et lancez une acquisition 

d’image à partir du logiciel. 
• Appuyez sur le boutonStart (Démarrer) (vert) du panneau de commande du Faxitron Core 

ou du logiciel. L’exposition aux rayons X commence alors. 
• Attendez que l’image soit affichée. 
• Utilisez la souris pour déplacer le curseur dans l’image affichée, vers le haut ou le bas pour 

régler les niveaux de luminosité/d’obscurité ou vers la gauche et la droite pour régler les 
niveaux de contraste faible/élevé. Déplacez le curseur jusqu’à ce que l’image atteigne le 
niveau souhaité. 

• Répétez le processus pour d’autres échantillons. 
 

Reportez-vous à la section 5.2 pour obtenir des instructions d’utilisation plus détaillées. 

Voir la section 6 du manuel de l’utilisateur pour connaître le fonctionnement avancé du logiciel. 

5.0.0 
Présentation du 
démarrage rapide 

 

 
Figure 5.0.1 
Panneau avant du Faxitron Core 
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Informations générales sur le démarrage 

La mise sous tension (démarrage du système) est effectuée une fois au début de l’utilisation 
du système. Une fois la séquence de mise sous tension terminée, il est recommandé de 
laisser le système SOUS TENSION le reste de la journée si vous prévoyez l’utiliser de nouveau. 

 
 

Protocole de la séquence de démarrage du système 

Mise sous tension du système 

• Allumez l’ordinateur et le moniteur et laissez-les démarrer complètement dans Windows. 

• Réglez l’interrupteur d’alimentation à l’arrière de l’armoire du  
Faxitron Core sur la position « Marche ». Voir Figure 5.1.1.

 
5.1.0 
Séquence de mise 
sous tension 

 
5.1.1 
Démarrage du 
système 

 
 

Figure 5.1.1 
• Tournez la clé située à l’avant de l’armoire du Faxitron Core en position 

« Marche » (dans le sens des aiguilles d’une montre jusqu’à la position 
de « 3 heures »). Voir Figure 5.1.2. 

• Vérifiez qu’il n’y a rien dans le tiroir à échantillons du Faxitron Core. 
 
 
 
 
 
 
 
 

 
Démarrage du logiciel 

• Double-cliquez sur l’icône Vision sur le bureau Windows. 
• Une boîte de dialogue s’affiche brièvement pour indiquer que le 

logiciel a été initialisé et qu’il est en train de se charger. 
• Le logiciel s’ouvre sur l’écran « Home Menu » (Menu d’accueil) ou 

sur l’écran « Calibration » (Étalonnage), en fonction du temps écoulé 
depuis le dernier étalonnage. 

 

 
 

 
 

 
 
 

 

Interrupteur d’alimentation principal 
 
 
 
 

 
Figure 5.1.2 
Interrupteur à clé 

 
 
 
 

 
Figure 5.1.3 
Icône de bureau VISION 

 
Le logiciel s’ouvre sur le « Home Menu » (Menu d’accueil) si un étalonnage a été effectué au 
cours des 12 dernières heures. 

Pour assurer une qualité d’image optimale, Hologic recommande d’étalonner le système au 
démarrage initial chaque jour ou si le système a été déplacé. 

 
Pour démarrer manuellement un étalonnage, cliquez sur le bouton Calibrate (Étalonner) dans 
le Home Menu (Menu d’accueil), puis sur le bouton Start Calibration (Démarrer étalonnage). 
Une fois l’étalonnage terminé, le logiciel retourne au Home Menu (Menu d’accueil). Voir 
Figures 5.1.4 et 5.1.5. 

 
 

 

Figure 5.1.4 
Bouton Start Calibration (Démarrer 
étalonnage) 

 
 
 
 
 
 
 
 

 
 

MARCHE 

MARCHE 

ARRÊT 

ARRÊT 
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Étalonnage 

REMARQUE : pour une qualité d’image optimale, il est recommandé d’étalonner le système 
au moins une fois par jour, avant la première utilisation. 

• Le logiciel s’ouvre à l’écran d’étalonnage si le dernier étalonnage a été effectué 
12 heures auparavant. 

• Appuyez sur le bouton Start Calibration (Démarrer étalonnage) et patientez jusqu’à 
ce que le système termine l’étalonnage. 

 
 

• La boîte de dialogue « Calibration » (Étalonnage) s’ouvre et indique la progression de 
l’étalonnage. 

 
• La boîte de dialogue se ferme lorsque l’étalonnage est terminé. Le logiciel passe à la 

page Home Menu (Menu d’accueil). 

5.1.2 
Étalonnage 

 
 

 
Figure 5.1.5 
Bouton Start Calibration (Démarrer 
étalonnage) 

 
 
 
 
 
 
 
 
 
 
 
 

Figure 5.1.6 
Boîte de dialogue d’étalonnage du 
système de radiographie 

 
 

Démarrage d’une procédure d’imagerie 
• À partir de la page Home Menu (Menu d’accueil) (voir Figure 5.1.4), sélectionnez le bouton 

Start Procedure (Démarrage de la procédure). 

• L’utilisateur pourra choisir entre Select from Work List (Sélectionner dans la liste de 
travail), Manual Entry (Saisie manuelle), Select from Database (Sélectionner dans la base 
de données) ou Continue with current patient (Continuer avec le patient actuel). Voir 
Figure 5.2.1. 

5.2.0 
Acquisition d’images 

 

 
 
 
Figure 5.2.1 
Boutons de saisie des données du 
patient 
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Pour saisir manuellement une nouvelle procédure, sélectionnez le bouton Manual Entry 
(Saisie manuelle). 

 REMARQUE : cette section ne traite que de la « Saisie manuelle » des données du 
patient, les autres options sont traitées à la section 6 de ce manuel. 

La boîte de dialogue « Patient Information Editor » (Éditeur d’informations sur le patient) 
s’ouvre. 

5.2.1 
Saisie manuelle 
des données du 
patient 

 
 

Figure 5.2.2 
Éditeur des informations d’imagerie 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Remarque : les champs obligatoires sont indiqués par un 
astérisque blanc (*). Les champs obligatoires par défaut sont 
les suivants : « Patient Name » (Nom du patient), « Patient 
ID » (ID du patient), « Accession Number » (Numéro d’ordre) 
et « Laterality » (Latéralité). 

 
Remplissez tous les champs obligatoires. Le bouton Accept (Accepter) n’est pas actif si l’un 
des champs obligatoires n’est pas rempli. L’utilisateur peut remplir d’autres champs s’il le 
souhaite. 

 
 

 Remarque : la date doit être saisie en format aaaa/mm/jj (p. ex., 1962/08/13). 
 
 

Sélectionnez Accept (Accepter) pour activer 

l’acquisition d’images. Le système est prêt à 

acquérir des images. 
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Capture d’une image/lancement de l’exposition aux rayons X 
Pour capturer une image radiographique avec le système Faxitron Core : 
• Ouvrez le tiroir du compartiment à rayons X en appuyant sur le bouton noir et placez le 

plateau du Faxitron Core contenant les échantillons dans le tiroir. Fermez le tiroir en 
appuyant de nouveau sur le bouton noir. 

• Appuyez sur le bouton vert de démarrage des rayons X sur le panneau de commande 
ou le logiciel. 

• Attendez que l’image s’affiche. 

5.2.2 
Démarrage de 
l’exposition 

 
 
 
 

Figure 5.2.3 
Tiroir de Faxitron Core 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 REMARQUE : le mode de radiographie par défaut du Faxitron Core est Full Auto 
(Entièrement automatique). Le système prend deux radiographies, la première pour 
régler les paramètres optimaux et la seconde pour capturer l’image. Les réglages utilisés 
pendant les expositions s’affichent à l’écran LCD de l’armoire. 

 
Le logiciel Vision est configuré pour enregistrer automatiquement l’image dans la base de 
données Faxitron sur le disque local de l’ordinateur du système. L’utilisateur peut également 
enregistrer l’image sur le serveur de l’établissement en cliquant sur l’icône PACS. Reportez-
vous aux sections 6.4.1, 6.6.0 et 6.7.0 pour plus d’informations sur l’enregistrement des images. 

 
Si vous souhaitez obtenir plus d’informations sur le réglage des paramètres d’image, des 
commandes de rayons X et des options d’analyse et d’enregistrement, consultez la section 6. 

 
Quitter le logiciel VISION 
Cliquez sur le bouton Shut Down (Mise hors tension), puis sur OK pour éteindre l’ordinateur. 
Il est possible de sélectionner la mise hors tension sur l’écran d’accueil ou l’écran d’acquisition 
d’images à l’aide des boutons présentés ci-dessous. 

 
Bouton Shut Down (Mise hors tension) sur l’écran 

d’acquisition. 

 
Bouton Shut Down (Mise hors tension) dans le Home 

Menu (Menu d’accueil). 
 
 

Éteindre l’armoire de radiographie Faxitron Core 
Une fois l’ordinateur éteint, réglez l’interrupteur à clé en position d’arrêt (la clé en position verticale). 

5.2.3 
Mise hors tension du 
système 

Figures 5.3.1 et 5.3.2 Boutons 
Shutdown System (Arrêt du 
système) et Exit Program (Quitter 
le programme) 

 
 

Bouton pour 
les rayons X 

 
Bouton pour 
le tiroir 

À l’écran  
« Start X-Ray » 

(Démarrer radiographie) 
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Le logiciel Vision est un ensemble complet d’acquisition et de traitement d’images, conçu 
exclusivement pour fonctionner avec les générateurs de rayons X Hologic (tels que les 
systèmes VersaVision, Faxitron Core et Faxitron OR). En plus des fonctions d’acquisition et 
de traitement, le logiciel offre un module de base de données complet qui permet à l’utilisateur 
de contrôler et de gérer l’archivage, le stockage, le classement et la récupération des images. 
Le logiciel est également conforme à la norme DICOM (Digital Imaging and Communications 
in Medicine, Imagerie numérique et communication en médecine), ce qui permet d’enregistrer 
et d’imprimer des images du patient en format DICOM 3.0. Le logiciel a été préinstallé sur 
l’ordinateur livré avec votre système de radiographie. 
 
L’étalonnage du système est requis au début de chaque nouvelle journée d’utilisation du 
système pour garantir la meilleure qualité d’image. L’utilisateur du système peut également 
effectuer un étalonnage à tout moment pour garantir une qualité d’image optimale. 

 
Après l’étalonnage, le menu d’accueil s’affiche, ce qui permet de naviguer vers toutes les 
autres zones du logiciel. Pour faciliter l’utilisation, des boutons d’application sont fournis. Voir 
Figure 6.0.1. Ces boutons se trouvent au centre de l’écran. Les descriptions et les définitions 
des boutons sont présentées dans les sections suivantes de ce manuel. 

 

 
Protocole de séquence 

Cette séquence de démarrage doit être respectée pour assurer le bon fonctionnement du 
système et la qualité des images : 

• Allumez l’armoire Faxitron Core à l’aide du commutateur situé à l’arrière de l’armoire 
(l’interrupteur se trouve à côté de la prise du cordon d’alimentation). Faites basculer sur 
« I » pour mettre en position « MARCHE » et sur « 0 » pour mettre en position « ARRÊT ». 

• Allumez le système Faxitron Core en insérant la clé Faxitron Core dans l’interrupteur à clé 
situé sur le panneau avant, et en la tournant dans le sens des aiguilles d’une montre jusqu’à 
la position de « 3 heures ».  Remarque : la clé ne peut pas être retirée dans cette position. 

• Allumez l’ordinateur et le moniteur. 

• Si Vision ne démarre pas automatiquement, double-cliquez avec le bouton 
gauche de la souris sur l’icône du logiciel Vision située sur le bureau de 
Windows. Voir Figure 6.1.1. Une boîte de dialogue s’affiche brièvement pour 
indiquer que le logiciel a été initialisé et qu’il est en train de se charger. 

• Le logiciel Vision s’ouvre sur le menu d’accueil (voir Figure 6.0.1.) ou sur 
la page d’étalonnage (voir Figure 6.2.2), en fonction du temps écoulé 
depuis le dernier étalonnage du système. 

• Reportez-vous à la section 6.2.0 « Présentation de l’étalonnage de la caméra » pour 
connaître les protocoles d’étalonnage. 

6.0.0 
Aperçu du logiciel 
Vision 

 
 
 
 
 
 
 
 

 
Figure 6.0.1 
Logiciel Vision 
Menu d’accueil (écran de 
démarrage) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

6.1.0 
Démarrage du 
logiciel 

 
 

 
 
Figure 6.1.1 
Icône du logiciel Vision sur le bureau 
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Introduction sur l’étalonnage 
Pour optimiser la qualité d’image, le logiciel Vision et le matériel nécessitent un étalonnage à 
intervalles réguliers. Cet étalonnage nécessite l’acquisition d’images de référence. 

 
Lors de la mise en service initiale du système ou à n’importe quel moment souhaité par 
l’utilisateur, un étalonnage du système peut être demandé et effectué. Il est recommandé 
d’effectuer les étalonnages suivants au bout de douze (12) heures. 

 
Ces images d’étalonnage de référence sont utilisées pour étalonner une image radiographique 
« brute » pixel par pixel, afin de générer une image « corrigée » pour l’affichage. Les corrections 
d’image effectuées comprennent des corrections de gain, de décalage et de linéarité. 

 
Séquence d’étalonnage 

Pour plus de commodité, le logiciel Vision combine les nombreuses étapes d’étalonnage en 
une étape unique. 

 
Lorsqu’un système de radiographie Hologic a été éteint pendant plus de douze (12) heures, le 
système demande automatiquement un nouvel étalonnage. Il est fortement recommandé 
d’étalonner le système à nouveau après une longue période d’inactivité ou après avoir déplacé 
le système dans une autre pièce où les paramètres de température/humidité ambiante peuvent 
être différents. 

 
Pour étalonner le système à tout moment, cliquez sur le bouton 
Calibrate (Étalonner) sur le menu d’accueil de Vision (écran de 
démarrage), puis appuyez sur Start Calibration (Démarrer 
l’étalonnage). Voir Figures 6.2.1 et 6.2.2. La boîte de dialogue 
affiche un message d’état pendant l’étalonnage. Voir Figure 6.2.3. 

 
 

 

 

Pendant l’étalonnage, des rayons X peuvent être générés. Pendant la génération des 
rayons X, un bouton Stop X-Ray (Arrêter les rayons X) devient visible pour permettre à 
l’utilisateur d’arrêter les rayons X à partir du logiciel. 

6.2.0 
Présentation de 
l’étalonnage de la 
caméra 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figure 6.2.1 
Bouton Calibrate (Étalonner) du 
menu d’accueil 

 
 
 
 
 

 
Figure 6.2.2 
Bouton Start Calibration (Démarrer 
étalonnage) 

 
 
 
 
 
 
 
 

Figure 6.2.3 
État de l’étalonnage 
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Voici un résumé du protocole d’étalonnage avancé pour « Both » (Les deux) (le champ plat et 
l’image) : 

Placez l’atténuateur uniforme sur le capteur. Toute la surface du capteur doit être couverte par 
l’atténuateur. Pour optimiser les résultats, l’atténuateur doit être plus grand que la zone 
d’imagerie du capteur. 

Sur l’écran de démarrage du logiciel d’imagerie, appuyez sur l’icône ^ située en haut à droite 
pour faire apparaître le menu. Sélectionnez l’élément du menu déroulant « Tools » (Outils) dans la 
barre de menu horizontale supérieure, puis passez à « Advanced Tools » (Outils avancés), puis à 
« X-Ray Calibration/Exposure Setup » (Étalonnage des rayons X/Configuration de l’exposition). 

 

 REMARQUE : les valeurs de tension (kV), de durée d’exposition et d’unités 
analogiques-numériques (ADU) peuvent différer de celles indiquées. 

 
• Sous « X-Ray Generator and Exposure Settings » (Générateur de rayons X et paramètres 

d’exposition), saisissez le réglage de la tension (kV) du générateur dans le champ approprié. 
• Laissez « Magnification » (Grossissement) au réglage par défaut de 1,450 (le grossissement 

est fixé dans le système Faxitron Core). 
• Sous « Set for » (Régler pour), sélectionnez « Both » (Les deux) dans la boîte de dialogue. 
• Conservez le réglage par défaut « user ADU target » (cible d’unité analogique-numérique de 

l’utilisateur). L’exposition aux rayons X sera terminée lorsque le capteur aura accumulé un 
niveau de signal moyen en unités analogiques-numériques acceptable pour votre générateur 
de rayons X. 

• Conservez la durée d’exposition par défaut du test et cliquez sur le bouton Acquire (Acquérir). 
Le système commencera automatiquement l’émission de rayons X et fera l’acquisition d’une 
image. 

• Lorsque l’exposition aux rayons X est terminée, cliquez sur le bouton Estimate/Calculate 
(Estimer/Calculer). 

• Enregistrez la valeur de la durée d’exposition calculée « Time [s] » (Durée [s]). Le système 
calcule cette durée et le nombre est affiché en gris. 

• Saisissez la valeur de la durée d’exposition calculée de « Time [s] » (Durée [s]) dans le champ 
« Test Exposure » (Exposition de test). Appuyez sur le bouton Acquire (Acquérir) pour 
lancer automatiquement l’émission de rayons X et l’acquisition d’une image. 

• Lorsque l’exposition aux rayons X est terminée, cliquez sur le bouton Estimate/Calculate 
(Estimer/Calculer). 

• Enregistrez la valeur de la durée d’exposition calculée « Time [s] » (Durée [s]). 
• Saisissez à nouveau la valeur de la durée d’exposition calculée dans le champ « Test 

Exposure » (Exposition de test). 

6.2.0 Suite 
 
 
 
 
 

 
Figure 6.2.4 
Boîte de dialogue X-Ray Generator 
and Exposure Settings (Réglages 
du générateur de rayons X et de 
l’exposition) 
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• Cliquez sur le bouton Accept Settings (Accepter les paramètres). 
• Effectuez une procédure d’étalonnage standard, tel que décrit dans la section « Présentation 

de l’étalonnage de la caméra ». 

Les utilisateurs expérimentés peuvent vouloir régler les paramètres d’exposition « X-Ray Cal 
(Flat-Field) » (Étalonnage des rayons X [champ plat]) et « Manual Image » (Image manuelle) 
séparément ou sur « Both » (Les deux) (champ plat et image manuelle), tel que décrit 
précédemment. La sélection du bouton radio « Flat Field » (Champ plat) permet au système 
de déterminer la durée d’exposition optimale pour l’acquisition d’images en champ plat avec le 
niveau d’unité analogique-numérique (ADU) souhaité. Par conséquent, la sélection de 
« Manual Image » (Image manuelle) détermine la durée d’exposition optimale pour le système 
avec un objet, ce qui atténue le signal des rayons X. Pour obtenir les meilleurs résultats, 
l’objet doit recouvrir toute la zone d’imagerie du capteur. 

Après la sélection de « X-Ray Cal (Flat-Field) » (Étalonnage des rayons X [champ plat]) et 
« Manual Image » (Image manuelle), le niveau d’unité analogique-numérique (ADU) est réglé. 
Sélectionnez le bouton Acquire (Acquérir). Pour la sélection « Manual Image » (Image 
manuelle), il est préférable que l’objet ou l’atténuateur de rayons X soit dans le faisceau de 
rayons X. Appuyez sur le bouton Acquire (Acquérir) pour générer des rayons X et obtenir une 
image. Lorsque l’exposition aux rayons X est terminée, cliquez sur le bouton 
Estimate/Calculate (Estimer/Calculer). Le système calcule la durée optimale et le nombre est 
affiché en gris. Cliquez sur le bouton Accept Settings (Accepter les paramètres) pour 
enregistrer les paramètres d’exposition dans le fichier de configuration du système. 

 Remarque : seuls les réglages du bouton radio sélectionné sont enregistrés. 

Ensuite, effectuez une procédure d’étalonnage standard, tel que décrit dans la section 
« Présentation de l’étalonnage de la caméra ». 

 

 
Il est parfois préférable d’incorporer les caractéristiques d’atténuation des rayons X d’un 
atténuateur uniforme dans les images d’étalonnage de référence en champ plat. Par exemple, 
si tous les objets qui doivent être balayés sont placés sur une mince plaque de plastique, les 
caractéristiques d’atténuation des rayons X de la plaque seront observées dans chaque 
image acquise. Dans ce cas, le fait de placer la plaque dans le faisceau de rayons X pendant 
l’acquisition de l’image d’étalonnage de référence en champ plat pourrait améliorer la qualité 
de l’image. 

 
 

Le bouton Start Procedure (Démarrer la procédure) (voir Figure 6.0.1) permet à l’utilisateur 
d’accéder à la page « Patient Data Entry » (Saisie des données du patient) qui propose 
différentes méthodes pour saisir les données du patient. Si aucune liste de travail n’a été 
configurée, l’option s’affiche en gris et seules les options Continue with current patient, 
Manual Entry et Select from Database (Continuer avec le patient actuel, Saisie manuelle et 
Sélectionner dans la base de données) sont accessibles. Les options sont expliquées dans 
les sections suivantes. 

6.2.0 Suite 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6.2.1 
Étalonnage avancé 

 
 
 
 

6.3.0 
Données du patient 

 
 
 
 

Figure 6.3.1 
Écran de saisie des données du 
patient 
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REMARQUE : toutes les 
données du patient sont fictives. 
Toute ressemblance avec une 
personne réelle est strictement une 
coïncidence. 

Sélectionner dans la liste de travail (liste de travail des modalités à 
distance) 

Si une liste de travail a été configurée, l’utilisateur peut cliquer sur le bouton Select from Work 
List (Sélectionner dans la liste de travail) pour afficher la page présentée dans la Figure 6.3.2. 

 

 
Les différents filtres sur la gauche peuvent être utilisés pour rechercher des procédures 
programmées pour l’entité d’application (EA) de la station de travail. Vérifiez que le titre de l’EA de la 
station de travail est défini. Ensuite, n’importe quel champ ou n’importe quelle combinaison de 
champs peut être utilisé comme filtre pour rechercher des procédures planifiées pour cette EA. La 
sélection du bouton Query (Interroger) situé dans le coin inférieur gauche, permet de remplir à 
nouveau le tableau avec les entrées correspondant aux informations recherchées. 

L’utilisateur peut alors cliquer sur n’importe quelle entrée, puis sur Submit (Soumettre) pour 
remplir automatiquement l’éditeur des informations d’imagerie avec les informations sur le patient. 

AVIS : l’utilisateur peut également double-cliquer sur n’importe quelle entrée du tableau pour 
accéder rapidement à l’éditeur des informations d’imagerie sans avoir à appuyer sur Submit 
(Soumettre). 

L’Éditeur des informations d’imagerie s’ouvre. Voir Figure 6.3.3. Remplissez les autres champs 
obligatoires et cliquez sur Accept (Accepter) pour procéder à l’acquisition d’images. 

6.3.1 
Sélectionner dans 
la liste de travail 
 
Figure 6.3.2 
Boîte de dialogue de recherche dans 
la liste de travail des modalités 
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Remarque : les champs obligatoires sont 

indiqués par un astérisque blanc (*). Les 
champs obligatoires par défaut sont les 
suivants : « Patient Name » (Nom du patient), 
« Patient ID » (ID du patient), « Accession 
Number » (Numéro d’ordre) et « Laterality » 
(Latéralité). 

L’utilisateur doit remplir tous les champs 
obligatoires avant de pouvoir sélectionner le 
bouton Accept (Accepter). L’utilisateur peut 
également saisir la date, le nom du médecin 
traitant, le nom de la procédure, le sexe, le 
nom du technicien, la vue de la position, la 
partie du corps et l’identifiant de l’étude, si 
nécessaire. Le nom de la procédure, la vue de 
la position et la partie du corps sont 
sélectionnés dans un menu déroulant. 

 
Remarque : la date doit être saisie en 
format aaaa/mm/jj (p. ex., 1962/08/13). La 
saisie d’une date non valide peut entraîner 
des erreurs lors de la récupération des 
images. 

 
Remarque : les « champs obligatoires » 
peuvent être modifiés ou supprimés, selon 
l’application. Contactez le service 
d’assistance de Hologic pour obtenir plus 
d’informations. 

 
Sélectionnez Accept (Accepter) pour continuer 
ou Start a New Patient or Procedure 
(Démarrer un nouveau patient ou une nouvelle 
procédure) pour revenir à la page de saisie 
des données du patient. 

6.3.1 Suite 
Figure 6.3.3 
Éditeur des informations d’imagerie 

 
 
 

Continuer avec le patient actuel 
Cliquez sur ce bouton pour continuer la procédure patient actuelle. L’Éditeur des 
informations d’imagerie s’ouvre. Voir Figure 6.3.3. Suivez la procédure et les remarques  
ci-dessus. 

6.3.2 
Continuer avec le 
patient actuel 

 
 

Saisie manuelle 
Cliquez sur ce bouton pour saisir manuellement une nouvelle procédure. L’Éditeur des 
informations d’imagerie s’ouvre. Voir Figure 6.3.3. Suivez la procédure et les remarques  
ci-dessus. 

6.3.3 
Saisie manuelle 
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Sélectionner dans la base de données 
 

La sélection du bouton Select from Database (Sélectionner dans la base de données) 
permet d’afficher la page suivante. Voir Figure 6.3.4 ci-dessous. 

 

 
 

L’utilisateur sélectionne un patient dans le tableau situé sur le côté droit de la page, puis 
clique sur le bouton Accept (Accepter) qui ouvre l’Éditeur des informations d’imagerie. (  
Remarque : l’utilisateur peut également double-cliquer sur l’entrée dans le tableau pour ouvrir 
l’Éditeur des informations d’imagerie.) Ensuite, suivez la procédure et les remarques de la 
page 6-7. 

 Remarque : utilisez la barre de défilement située en bas de l’écran pour afficher les 
informations sur le patient qui sont masquées. 

Vision permet à l’utilisateur de restreindre la liste des patients en saisissant des informations 
spécifiques dans la fenêtre « Search Parameters » (Paramètres de recherche) située sur le 
côté gauche de la page. Seuls les patients qui respectent tous les paramètres de recherche 
seront affichés. 

6.3.4 
Sélectionner dans 
la base de données 
Figure 6.3.4 
Sélection du patient à partir des 
entrées de la base de données 
locale 

 
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

REMARQUE : toutes les données 
du patient sont fictives. Toute 
ressemblance avec une personne 
réelle est strictement une 
coïncidence. 
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Si l’utilisateur souhaite modifier ou afficher les informations après leur saisie, 
mais avant la prise d’une image, il peut appuyer sur l’icône Patient Data (Données 
du patient) dans le coin supérieur gauche de l’écran. Voir Figure 6.3.5. 

 

 
La fenêtre de l’éditeur des informations sur le patient/d’imagerie s’ouvre alors. Cette fenêtre 
d’édition contient toutes les informations précédemment saisies ou sélectionnées. Voir 
Figure 6.3.6.  Remarque : la fenêtre d’édition comprend désormais un bouton Cancel 
(Annuler). 

 
L’utilisateur peut modifier ou ajouter des 
informations, si nécessaire, puis cliquer sur : 

• le bouton Accept (Accepter) pour 
enregistrer les modifications et poursuivre 
l’acquisition d’images, 

• le bouton Cancel (Annuler) pour annuler 
les modifications et poursuivre 
l’acquisition d’images. Le logiciel 
reviendra aux informations saisies 
initialement sur le patient, ou 

• le bouton Start a New Patient or 
Procedure (Démarrer un nouveau 
patient ou une nouvelle procédure) pour 
ramener l’utilisateur à l’écran « Patient 
Data Entry » (Saisie des données du 
patient). Voir Figure 6.3.1. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Une fois que l’utilisateur a cliqué sur le bouton Accept (Accepter), le système est prêt pour 
l’acquisition d’images/de radiographies. 

On lance la génération de rayons X en appuyant sur le bouton vert Start (Démarrer) situé à 
l’avant de l’armoire Faxitron Core ou en cliquant sur le bouton Start X-Ray (Démarrer les 
rayons X) situé dans le coin inférieur droit de l’écran. Voir la section 5.2.2, Démarrage de 
l’exposition. Le système prendra une courte radiographie « d’échantillon », ou pré-image 
(expliquée à la section 6.4.4), suivie d’une exposition plus longue pour acquérir l’image. Le 
logiciel traite l’image avant de l’afficher sur l’écran du moniteur. Une fois l’image affichée, 
les boutons situés à gauche et à droite de l’écran, couverts tout au long de cette section, 
seront activés. 

6.3.5 
Icône des données du 
patient 
Figure 6.3.5 
Icône des données du patient 

 
 

 
Figure 6.3.6 
Éditeur des informations d’imagerie 
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L’utilisateur peut afficher, mais pas modifier, les 
informations sur le patient après l’acquisition d’une 
image en cliquant sur l’icône Données du patient 
présentée à la Figure 6.3.5. Une boîte de dialogue 
d’informations sur le patient modifiée s’affiche, 
comme illustré à la Figure 6.3.7. Cette boîte 
contient deux boutons : Close Dialog (Fermer la 
boîte de dialogue) ou Start a New Patient or 
Procedure (Commencer un nouveau patient ou une 
nouvelle procédure). L’utilisateur peut afficher, 
mais pas modifier, les informations sur le patient 
après l’acquisition d’une image en cliquant sur 
l’icône Patient Data (Données du patient) 
présentée à la Figure 
6.3.4. Une boîte de dialogue d’informations sur le 
patient modifiée s’affiche, comme illustré à la 
Figure 6.3.7. Cette boîte contient deux boutons : 
« Close Dialog » (Fermer la boîte de dialogue) ou 
« Start a New Patient or Procedure » (Commencer 
un nouveau patient ou une nouvelle procédure). 

 
 
 
 
 
 
 
 
 
 

 
 
 

Après la prise d’une image, les 
propriétés de l’image actuelle 
peuvent être affichées en 
appuyant sur l’icône (i) dans le 
coin supérieur droit. Voir 
Figure 6.3.8. La boîte de 
dialogue « Image Properties » 
(Propriétés de l’image) s’affiche 
dans le coin supérieur droit de 
l’image. La boîte est semi-
transparente pour permettre de 
voir ce qui se trouve en 
dessous. Voir Figure 6.3.9. 

6.3.5 Suite 
Figure 6.3.7 
Boîte de dialogue Patient 
Information (Informations sur le 
patient) après l’acquisition d’images 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 6.3.8 
Boîte de dialogue Image Properties 
(Propriétés de l’image) 

 

 
Figure 6.3.9 
Image Properties (Propriétés de 
l’image) (affichage uniquement) 
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Le logiciel Vision fournit plusieurs outils et menus pour contrôler les attributs ou paramètres 
des images, l’acquisition de radiographies, les vues d’image, les outils d’image et les 
paramètres/accès DICOM. Les outils les plus couramment utilisés se trouvent dans une barre 
d’outils. La barre d’outils et les menus sont décrits plus en détail dans les pages suivantes. 

 

 
Le logiciel Vision permet d’accéder d’un seul clic à un certain nombre d’outils et de fonctions 
couramment utilisés, à partir d’une barre d’outils verticale située sur le côté gauche de l’écran. 
Des descriptions détaillées sont présentées dans les pages suivantes. Voir Figure 6.4.1. 

 
 

 
Afficher/modifier les informations sur le patient 
(voir Section 6.3.5 et Figure 6.3.5) 

 

 
Icône de rehaussement de l’image 

 
 

 
Outil de contraste et niveau de la fenêtre 

 

 
Outil de zoom numérique 

6.4.0 
Barre d’outils et 
menus 

 
 

6.4.1 
Barre d’outils latérale 

 

 
Figure 6.4.1 
Barre d’outils latérale 

 

 
Outils d’annotation 

 
 

 
Enregistrement PACS 

 
 
 

Impression PACS 
 
 
 

Contrôle de l’exposition (panneau de 
commande du dispositif) 

 
 
 

Retour au menu principal 
 
 
 

Arrêt du système 

 REMARQUES : 
 

Les outils suivants sont toujours actifs dans 
la page d’acquisition d’images : 
• Afficher/modifier les informations sur le 

patient 
• Contrôle de l’exposition, 
• Retour au menu principal, et 
• Arrêt du système 

Les outils suivants seront désactivés 
après la saisie des données du 
patient et ils seront activés 
uniquement après l’acquisition d’une 
image radiographique : 
• Rehaussement de l’image, 
• Contraste et niveau de la fenêtre, 
• Zoom numérique, et 
• Annotation 

Les outils d’enregistrement PACS et 
d’impression PACS sont activés 
uniquement après l’acquisition d’une 
image radiographique et lorsque le 
système est connecté à un réseau 
PACS. 
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Rehaussement de l’image 
Le bouton présenté à la Figure 6.4.2 traite l’image sur l’écran pour mettre en évidence les 
détails plus petits, tels que les micro-calcifications et les petites masses dans 
l’image. 

 

 
L’algorithme, communément appelé « Peripheral Equalization » (Égalisation périphérique) ou 
« Thickness Equalization » (Égalisation de l’épaisseur) en imagerie avancée, est appliqué à 
l’ensemble de l’image. En plus de cet algorithme, Hologic utilise un second algorithme 
développé à l’interne appelé « Calcification Emphasis » (rechaussement de la calcification). 
Cet algorithme secondaire a été conçu pour faire ressortir les petits détails de l’image et les 
rendre beaucoup plus faciles à voir et à analyser. 

 
Étant donné que les images des patients constituent une catégorie plus générale pour les 
géométries et les différentes épaisseurs possibles, certains échantillons peuvent avoir des 
géométries complexes et l’utilisateur doit utiliser cet outil avec prudence. 

 
Le système sera inactif (en veille) pendant le traitement et une fois le traitement terminé, le 
bouton restera enfoncé/actif. L’utilisateur peut annuler le processus en appuyant à nouveau 
sur le bouton. 

6.4.1 Suite 

 
Figure 6.4.2 
Icône du rehaussement de l’image 
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Réglage de l’inversion, du niveau de la fenêtre et du contraste de 
l’image 

Le bouton présenté à la Figure 6.4.3 ouvre l’outil de réglage du niveau de la fenêtre et du 
contraste de l’image. Cet outil permet à l’utilisateur de régler le niveau de fenêtre et le 
contraste de l’image. L’utilisateur peut également restaurer le contraste original en appuyant 
sur le bouton Original Contrast (Contraste d’origine) ou inverser l’image en appuyant sur le 
bouton Invert (Inverser). L’inversion fait passer la palette de couleurs d’une prédominance de 
noir à une prédominance de blanc et vice versa. Voir Figure 6.4.4 ci-dessous. 

 
 
 
 
 
 
 
 
 
 
 
 

L’utilisateur peut également ajuster le contraste d’image 
désiré en cliquant sur la barre de défilement et en la 
déplaçant vers le haut ou vers le bas, ou en cliquant sur l’une 
des flèches indiquées sur la barre pour déplacer les limites 
inférieure ou supérieure du niveau de la fenêtre. Voir Figure 
6.4.3 Cette fonction est officieusement connue sous le nom 
de « Window Leveling » (Mise à niveau de la fenêtre). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Un exemple d’inversion est présenté ci-dessous : 

6.4.1 Suite 
 
 
 

 

 
Figure 6.4.3 
Icône et commandes Contrast Tool 
(Outil de contraste) et Window 
Level (Niveau de la fenêtre) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figure 6.4.4 
Exemple d’inversion avec l’outil 
de contraste et niveau de la 
fenêtre 
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Réglage dynamique du zoom 

L’icône Zoom Tool (Outil de zoom) présentée à la Figure 6.4.5 ouvre l’outil de réglage du 
zoom. Après avoir ouvert cet outil, l’utilisateur peut utiliser la barre de défilement pour régler le 
niveau de zoom ou bien cliquer sur les boutons pour Fit to Specimen (Ajuster à la taille de 
l’échantillon), Fit to Screen (Ajuster à la taille de l’écran) ou Zoom 1.0x (Zoom x 1,0) (pleine 
résolution). Voir Figure 6.4.6. Lorsqu’un zoom a été effectué sur l’image, un panoramique est 
nécessaire pour naviguer dans l’image. Une boîte de dialogue sous forme de vignette 
s’affiche dans le coin supérieur gauche de l’écran. Voir Figure 6.4.7 ci-dessous. Cliquez avec 
le bouton gauche sur l’image et maintenez-le enfoncé, puis déplacez la souris pour déplacer 
l’image dans l’écran principal. 

 
 Notez que traditionnellement, cette fonction est aussi appelée « Pan View » 

(Panoramique) et/ou « Pan and Scan » (Panoramique et balayage). 
 

 

 

 
Le bouton Fit to Specimen (Ajuster à la taille de l’échantillon) tente de 
détecter et d’effectuer un zoom sur l’échantillon, pour s’assurer qu’il est 
entièrement visible. Si aucun échantillon n’est détecté, il revient par 
défaut au mode précédent, soit « Fit to Screen » (Ajuster à la taille de 
l’écran), soit « Zoom 1.0 x » (Zoom x 1,0). 

 
L’option Fit to Screen (Ajuster à la taille de l’écran) ajuste la taille de 
l’image pour s’assurer qu’elle est entièrement visible sur l’écran. 

 
Le Zoom 1.0x (Zoom 1,0) est traditionnellement appelé « Full Resolution » 
(Pleine résolution), car il amène l’image à la taille 1-1 avec la résolution 
du moniteur. 

 
 

Annotations 
Le bouton présenté à la Figure 6.4.8 ouvre les outils d’annotation. Ces outils et leurs 
nombreuses options sont présentés plus en détail à la section 6.8.0. 

6.4.1 Suite 
 
 
 
 
 

 

 
Figure 6.4.5 
Icône de l’outil de zoom 

 
 

Figure 6.4.6 
Outil de réglage du niveau de zoom 

 
 
 

Figure 6.4.7 
Exemple de panoramique (à 
gauche) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figure 6.4.8 
Icône des annotations 
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Stockage PACS 
Le bouton présenté à la Figure 6.4.9 fonctionne uniquement lorsque le système est 
installé dans un établissement médical disposant d’un réseau PACS. Pour 
enregistrer vos fichiers localement, consultez la section 6.7.0. 

 
 

Impression PACS 
Le bouton présenté à la Figure 6.4.10 fonctionne uniquement lorsque le système 
est installé dans un établissement médical disposant d’un réseau PACS. Pour une 
impression locale, consultez la section 6.7.0. 

 
 

Panneau de commande du dispositif 
Le bouton présenté à la Figure 6.4.11 ouvre le panneau de commande du 
dispositif, ce qui permet à l’utilisateur du dispositif de contrôler le système de 
rayons X par le biais du logiciel. L’utilisateur peut facilement sélectionner le mode 
d’exposition, les réglages de la tension (kV) du tube radiogène, la durée 
d’exposition et le nombre d’images à acquérir pour le calcul de la moyenne des 
images (si désiré), puis lancer l’exposition aux rayons X. 

 
 

 REMARQUE : l’état ou la disponibilité des 
paramètres d’exposition est indiqué par les flèches 
haut/bas situées à côté de chaque paramètre. Les 
flèches sont blanches pour les paramètres actifs et 
bleu clair pour les paramètres inactifs. Les paramètres 
d’exposition actifs dépendent du mode d’exposition 
sélectionné. 

La Figure 6.4.12 à droite montre que le mode « Full 
Manual » (Entièrement manuel) a été sélectionné et 
que la tension (kV), la durée d’exposition et les 
moyennes des images sont toutes actives. L’utilisateur 
peut ajuster chacun de ces paramètres. 

6.4.1 Suite 
Figure 6.4.9 
Icône de stockage PACS 

 
 
 

 
Figure 6.4.10 
Icône d’impression PACS 

 
 
 
 
 

Figure 6.4.11 
Icône du Panneau de commande du 
dispositif 

 
 
 
 

Figure 6.4.12 
Panneau de commande du dispositif 

 
 
 
 

 Notez que le réglage mA dans le système Faxitron 
Core n’est pas réglable par logiciel et qu’il restera 
toujours inactif. 

 
 

 
Lorsque vous avez terminé, cliquez sur le bouton 
Request X-Rays (Demande de radiographie) pour 
acquérir une image ou sur le bouton Set (Définir) pour 
enregistrer les paramètres et fermer le panneau de 
commande du dispositif. 

 
Si vous cliquez sur le bouton Cancel (Annuler), le 
panneau de commande du dispositif se ferme sans 
enregistrer les modifications. 
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Retour à la procédure 
Le bouton présenté à la Figure 6.4.13 permet de quitter le mode d’acquisition 
d’images et de revenir à l’écran du menu principal. 

 
 

Arrêt 
Le bouton présenté à la Figure 6.4.14 permet de quitter le logiciel et d’arrêter 
l’ordinateur. 

6.4.1 Suite 
Figure 6.4.13 
Icône de retour au menu d’accueil 

 
 

 
Figure 6.4.14 
Icône d’arrêt du système 

 

 
Remarques supplémentaires concernant les boîtes de dialogue 

Lorsqu’une boîte de dialogue est ouverte, elle est « ancrée » à gauche de l’écran. Si un 
utilisateur souhaite désancrer la boîte de dialogue, il peut cliquer sur l’icône d’épingle en haut 
à droite pour désancrer la boîte de dialogue et pouvoir la faire glisser librement. Ensuite 
l’icône d’épingle se transforme en « X » permettant une fermeture rapide. 

Les utilisateurs peuvent également naviguer rapidement entre les différentes boîtes de 
dialogue en cliquant sur le menu de gauche. Ainsi, le menu de gauche se ferme rapidement et 
ouvre les boîtes de dialogue appropriées. 

 
 

Barre de menu supérieure 
Le logiciel permet d’accéder aux menus « View » (Affichage), « Tools » (Outils), « Image 
tools » (Outils d’image), « DICOM Utilities » (Utilitaires DICOM) et « Help » (Aide) dans la 
barre de menu supérieure. Voir Figure 6.4.15. La barre de menu supérieure est masquée par 
défaut et s’affiche en cliquant sur la flèche située dans le coin supérieur droit de l’écran. Voir 
Figure 6.4.16. La flèche est noire ou blanche, selon la page du logiciel/l’arrière-plan de 
l’écran. Chaque option du menu est décrite plus en détail dans les pages suivantes. 

 

 Remarque : la flèche pointe vers le bas lorsque la barre de menu 
supérieure est masquée et vers le haut lorsqu’elle est affichée. 

 
 

Menu View (Affichage) 
Le menu « View » (Affichage) est situé dans la barre de menu supérieure. Il contient les 
éléments de sous-menu présentés à la Figure 6.4.17 ci-dessous. Chacune de ces options est 
décrite en détail dans les pages suivantes. 

6.4.2 
Barre de menu 
supérieure 

 
 
 
 

Figure 6.4.15 
Barre de menu supérieure 

Figure 6.4.16 
Boutons de la barre de menu 
supérieure 

 
 

6.4.3 
Menu View 
(Affichage) 
 
Figure 6.4.17 
Menu View (Affichage) 
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Zoom Mode (Mode zoom) 
 

Normal 
Affiche l’image acquise dans son format original. Le format natif de l’image Faxitron Core 
s’affiche entièrement dans la zone d’affichage du moniteur. L’utilisateur peut effectuer un 
zoom avant sur l’image si nécessaire. Reportez-vous au Réglage dynamique du zoom à la 
section 6.4.1. 

 
Adjust Zoom (Régler le zoom) 

Cette option est affichée en gris et n’est pas disponible pour le moment. 

 
Fit to Sample (Ajuster à la taille de l’échantillon) 

Cette option ajuste l’image acquise pour qu’elle corresponde le mieux à l’échantillon dans la 
zone d’affichage du moniteur. 

6.4.3 Suite 

Fit All (Ajuster tout) 
Cette option affiche l’ensemble de l’image acquise, peu importe son format d’origine. L’option 
Full Resolution (Pleine résolution) ne fonctionne pas dans ce mode d’affichage. 

 
Fit Width (Ajuster la largeur) 

Cette option affiche l’image acquise sur toute la largeur disponible de la zone d’affichage. 

 
Fit Height (Ajuster la hauteur) 

Cette option affiche l’image acquise sur toute la hauteur disponible de la zone d’affichage. 

 
Image Averages (Moyennes des images) 

Cette option permet à l’utilisateur de régler le nombre de moyennes d’images à prendre par 
exposition. Les options disponibles sont les suivantes : prises de vue 1x, 2x, 4x ou 8x. Le 
réglage par défaut est une prise de vue 1x. Si l’utilisateur sélectionne 2, 4 ou 8 prises de vue, 
le logiciel acquiert le nombre d’images sélectionné de manière consécutive, sur simple 
pression du bouton Start (Démarrer) et calcule la moyenne de ces images pour en faire une 
seule image. 

 
Image Perspective (Perspective de l’image) 

Cette option permet à l’utilisateur de faire pivoter l’image affichée de 0, 90, 180 et 270 degrés 
pour l’orienter. 
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Grid options (Options de grille) 
Lorsqu’une image acquise ou récupérée de la base de données est affichée, l’utilisateur peut 
activer une grille. Elle permet également à l’utilisateur de régler l’espacement (le pas) de la 
grille. Voir l’exemple ci-dessous. 

 
 

User Window Levels (Niveaux de fenêtre de l’utilisateur) 
Cela permet à l’utilisateur de choisir jusqu’à trois (3) niveaux de fenêtre (WL) prédéfinis. 
Sélectionnez d’abord le bouton Window Level (Niveau de fenêtre) et réglez le niveau WL 
souhaité. Dans les outils « View » (Affichage), sélectionnez « User Window Levels » (Niveaux 
de fenêtre de l’utilisateur). Sélectionnez « Record Current WL » as USER WL #1, #2 or #3 
(Enregistrer le WL actuel en tant que WL D’UTILISATEUR N°1, N°2 ou N°3). Le WL 
sélectionné sera enregistré sous le choix précédent. 

 
Default Window Level (Niveau de fenêtre par défaut) 

L’utilisateur dispose de deux choix de « Default Window Levels » (WL) (Niveau de fenêtre 
(WL) par défaut). L’option « Optimize for whole area » (Optimiser pour la zone entière) qui 
ajuste le WL de l’image entière ou l’option « Optimize for sample » (Optimiser pour 
l’échantillon) qui ajuste le WL de la zone sous l’échantillon uniquement. De plus, il existe une 
option « Set Default Window Level » (Réglage du niveau de fenêtre par défaut) utilisée pour 
toutes les images obtenues situées au même endroit. Cette action définit le niveau de la 
fenêtre par défaut en fonction des statistiques des images et devra être effectuée séparément 
pour les images rehaussées et non rehaussées. 

6.4.3 Suite 
 

 
Figure 6.4.18 
Affichage de grille de l’échantillon 

Default Aspect of Raw Files (Aspect par défaut des fichiers bruts) 
Cela permet d’importer/ouvrir des fichiers d’images précédemment enregistrés avec des 
attributs de fichiers inconnus ou des données d’images binaires sans aucune information d’en-
tête. Étant donné que la taille exacte du tableau de l’imageur n’est pas disponible dans l’en-
tête du fichier de données d’image, les dimensions de l’imageur les plus proches seront 
utilisées pour importer/ouvrir ces images, en se basant sur le fait que la largeur est supérieure 
ou inférieure à la hauteur (informations sur l’aspect par défaut). 

 
Enhance Image (Rehausser l’image) (identique au bouton du même nom) 

Cet outil traite l’image du patient actuel et rehausse les tissus situés à proximité de la 
périphérie de l’échantillon. 
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Sample Viewer (Visionneuse d’échantillons) 
Sample Viewer (Visionneuse d’échantillons) permet d’actionner un visionneur de webcaméra 
pour faciliter l’alignement des échantillons. Une webcaméra ne peut pas être ajoutée au 
système Faxitron Core. 

Magnifier Size (Taille de la loupe) 
Permet à l’utilisateur de sélectionner la taille de l’outil Loupe (voir le menu « Image tools » 
(Outils d’image)). Les options sont « Small » (Petite), « Medium » (Moyenne) et « Grande ». 

 
Review Layout (Mise en page de la révision) 

Permet à l’utilisateur de configurer plusieurs fenêtres d’image en mode « Review » (Révision) 
(base de données) du programme. Les options disponibles pour la mise en page sont « (1 X 
1) single » (Simple [1 X 1]), « (2 X 1) Double H » (Double H [2 X 1]), « (1 X 2) Double V » 
(Double V [1 X 2]), « (1 + (2 X 1) Triple » (Triple 1 + (2 X 1)] et « (2 X 2) Quadruple » 
(Quadruple [2 X 2]). Lors de l’utilisation de plusieurs fenêtres, l’utilisateur peut cliquer une fois 
sur la fenêtre/l’image souhaitée pour la sélectionner, et sa bordure rectangulaire deviendra 
verte. Dans la vue de la liste des bases de données ou dans la vue des vignettes de la base 
de données, il est possible d’ouvrir les images dans la fenêtre sélectionnée en double-cliquant 
dessus. L’utilisateur peut également ouvrir les images dans les fenêtres souhaitées 
directement en cliquant droit dans le menu des vues de base de données mentionnées. Une 
fois que le menu où l’on peut cliquer droit est activé, l’utilisateur peut sélectionner les fenêtres 
de la liste sous OPEN TO→ (OUVRIR VERS →) pour ouvrir l’image à gauche, à droite, en 
haut, en bas, etc. 

 
Menu Tools (Outils) 

Le menu « Tools » (Outils) se trouve dans la barre de menu supérieure située dans le coin 
supérieur gauche de l’écran principal. 

 
 

Preferences (Préférences) 
Le menu « Preferences » (Préférences) ouvre un utilitaire de gestion de configuration qui peut 
être utilisé pour modifier divers options ou paramètres. 

 REMARQUE : l’option d’outil « Preferences » (Préférences) est protégée par un mot de 
passe et doit être accessible uniquement pour un représentant autorisé du service 
d’assistance de Hologic. 

 REMARQUE : toute modification des paramètres de configuration sans connaissance ou 
autorisation appropriée peut entraîner une perte de la qualité des images, des dommages au 
système et un mauvais fonctionnement du système. 

6.4.3 Suite 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6.4.4 
Menu Tools (Outils) 

 
Figure 6.4.19 
Menu Tools (Outils) 
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Service Mode (Mode entretien) 

Le « Service Mode » (Mode entretien) est protégé par un mot de passe et il est activé par les 
techniciens agréés de Hologic à des fins de dépannage. 

 
Service Tools (Outils d’entretien) 

Le « Service Tools » (Outils d’entretien) est habituellement affiché en gris. Il est activé 
uniquement lorsque le système est en « Service Mode » (Mode entretien). 

Save Reference Files (Enregistrer les fichiers de référence) 
« Save Reference Files » (Enregistrer les fichiers de référence) est habituellement affiché en 
gris. Il est activé uniquement lorsque le système est en « Service Mode » (Mode entretien). 

 
Options Advanced Tools (Outils avancés) 

Les « Advanced tools » (Outils avancés) offrent plusieurs options pour configurer certains 
aspects du logiciel, tels que le post-traitement et la configuration. 

 
Auto Save On/Off (Enregistrement automatique Marche/Arrêt) 

Lorsque « Auto save » (Enregistrement automatique) est activé, toutes les images acquises 
par la suite sont enregistrées dans la base de données. Les fichiers sont écrits dans un 
répertoire de données défini dans le fichier de configuration. 

 
X-Ray Calibration/Exposure Set-up (Étalonnage des  

rayons-X/Configuration de l’exposition) 
Cet outil est disponible dans Advanced Tools (Outils avancés). La fonction « X-Ray 
Calibration/Exposure Set-up » (Étalonnage des rayons X/Configuration de l’exposition) permet 
à l’utilisateur de déterminer la durée d’exposition appropriée pour un réglage de tension (kV) 
sélectionné, afin d’obtenir la meilleure qualité d’image possible. Veuillez consulter la 
section 6.2.0 et la Figure 6.2.4 pour une description plus détaillée. 

 
Preshot AEC Exposure Setup (Configuration de l’exposition de la 

pré-image par AEC) 
Le système Faxitron Core utilise le contrôle automatique de l’exposition (AEC) pour fournir la 
meilleure qualité d’image possible sur simple pression sur le bouton Start X-ray (Démarrer les 
rayons X). Le logiciel utilise une exposition « Preshot » (Pré-image) pour calculer les valeurs 
optimales de la tension (kV) et de la durée d’exposition. La « Preshot » (Pré-image) est une 
exposition aux rayons X de courte durée, habituellement de 2 à 3 secondes. Le logiciel 
analyse les résultats pour déterminer la tension (kV) et le temps nécessaires pour produire la 
meilleure qualité d’image. La « Preshot AEC Exposure » (Exposition de la pré-image par 
AEC) est configurée en usine et activée par défaut. 

La « Preshot AEC Exposure Setup » (Configuration de l’exposition de la pré-image par AEC) 
permet à l’utilisateur d’ajuster le système aux besoins particuliers d’un examen d’imagerie ou 
pour compenser le vieillissement du système. 

Pour accéder à la boîte de dialogue de « Preshot AEC Exposure Setup » (Configuration de 
l’exposition de la pré-image par AEC) à partir de la barre de menu supérieure, sélectionnez 
« Tools » (Outils), « Advanced Tools » (Outils avancés) et « PRESHOT AEC Exposure 
Setup » (Configuration de l’exposition de la pré-image par AEC). Voir Figure 6.4.19. La boîte 
de dialogue Preshot AEC Settings (Réglages de pré-image par AEC) illustrée à la 
Figure 6.4.20 s’ouvre. 

6.4.4 Suite 
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Saisissez les valeurs d’AEC pour la pré-image dans la fenêtre affichée à droite.  
Les paramètres affichés 
reflètent une exposition de 
23 kV et de 2 secondes avec 
une intensité cible de 
8 000 ADU pour le réglage de la 
pré-image. Les utilisateurs ne 
peuvent entrer les paramètres 
de pré-image que lorsque 
DYNAMIC METHOD 
(MÉTHODE DYNAMIQUE) 
(dans la section PRESHOT 
ANALYSIS METHOD 
(MÉTHODE D’ANALYSE DE 
PRÉ-IMAGE)) est sélectionnée. 
La sélection de STATIC 
METHOD (MÉTHODE 
STATIQUE) permet d’utiliser 
des paramètres Hologic 
prédéfinis. De plus, l’utilisateur 
a la possibilité de sélectionner 
les paramètres de tension (kV) 
et de durée d’exposition dans la 
section « EXPOSURE TUNING 
METHOD » (MÉTHODE 
D’AJUSTEMENT DE 
L’EXPOSITION). 

Pour obtenir des images plus 
précises, l’utilisateur peut saisir 
l’épaisseur de « SOFT 
TISSUE » (TISSU MOU; 
échantillon) et la TARGET 
INTENSITY (INTENSITÉ 
CIBLE) en ADU. 

 Remarque : les valeurs 
indiquées se situent dans la plage typique d’un système Faxitron Core, mais peuvent varier. 

Pour le mode AUTOMATIC EXPOSURE CONTROL (COMMANDE D’EXPOSITION AUTOMATIQUE), 
appuyez sur le bouton Start (Démarrer) du logiciel Vision (ou sur le panneau de commande). Le 
logiciel Vision capture une pré-image (pré-exposition courte et faible) de l’échantillon, pour créer une 
région d’intérêt (RI), afin de définir les paramètres d’exposition optimale de l’image. 

 
Login Utility (Utilitaire de connexion) 

Le « Login Utility » (Utilitaire de connexion) est disponible dans le menu « Advanced Tools » 
(Outils avancés). Il permet à l’utilisateur de configurer et d’activer l’authentification par mot de 
passe au démarrage du logiciel Vision. L’activation de cette fonctionnalité est facultative sur le 
système Faxitron Core. Si l’utilisateur 
active l’authentification par mot de 
passe, il sera invité à saisir son mot de 
passe à chaque ouverture du 
programme. Le programme se ferme 
si le mot de passe saisi est incorrect. 

6.4.4 Suite 
Figure 6.4.20 
Preshot AEC Exposure Setup 
(Configuration de l’exposition de la 
pré-image par AEC) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 6.4.21 
Login Utility (Utilitaire de connexion) 
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Properties (Propriétés) 

L’option « Properties » (Propriétés) masque ou affiche la boîte de dialogue d’informations sur l’image. 
Voir Figure 6.3.9. 

Edit Current Image Record (Modifier l’enregistrement de 
l’image actuelle) 

6.4.4 Suite 

Actuellement non utilisé. 
 

Delete Current Image Record  
(Supprimer l’enregistrement de l’image actuelle) 

Supprime l’image actuelle du répertoire de fichiers, tel que spécifié dans le fichier de configuration. 
 

Add Current Image Record 
(Ajouter l’enregistrement de l’image actuelle) 

Ajoute l’image actuelle au répertoire de fichiers, tel que spécifié dans le fichier de configuration. 
 

Capture Screen Shot JPG/BMP 
(Capture d’écran en format JPG/BMP) 

En sélectionnant cette option de menu, l’utilisateur peut effectuer une capture d’écran de la 
fenêtre active affichée. L’utilisateur peut spécifier un nom de fichier et choisir d’enregistrer le 
fichier en format JPG ou BMP. 

 
 
 

 

 
 

Save/Store Current Image (Enregistrer/stocker l’image actuelle) 
L’utilisateur peut « naviguer » jusqu’au répertoire ou au dossier de fichiers dans lequel l’image 
doit être enregistrée. Un nom de fichier doit être attribué dans le champ prévu à cet effet. 
L’utilisateur peut enregistrer l’image sous forme de fichier BMP, JPEG, TIF, RAW Data ou DICOM. 
Pour enregistrer le fichier en format DICOM, consultez la section « Fonctionnalité DICOM ». 

Print Current Image (Imprimer l’image actuelle) 
Imprime l’image actuelle sur l’imprimante Windows. 

 
Image Tools (Outils d’image) 

Les fonctions suivantes sont disponibles pour modifier l’image acquise ou récupérée en 
cliquant sur le menu « Image tools » (Outils d’image). Voir 
Figure 6.4.22. Les options du sous-menu sont accessibles ou 
peuvent être activées d’un simple clic sur l’option souhaitée. 

 
 
 
 
 
 

6.4.5  
Image Tools (Outils 
d’image) 

 
Figure 6.4.22 
Menu Image Tools (Outils d’image) 
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Original Contrast (Contraste d’origine) 
L’option « Original Contrast » (Contraste d’origine) rétablit les niveaux de contraste de l’image. 
Cette fonction est identique à celle du bouton Original Contrast (Contraste d’origine) de l’outil 
Window Level and Contrast (Contraste et niveau de la fenêtre). Voir Section 6.4.1 et Figure 6.4.3. 

6.4.5 Suite 

Invert (Inverser) 
L’option « Invert » (Inverser) permet l’inversion ou le renversement de l’image affichée. 
L’inversion d’une image inverse sa transparence : ce qui est noir devient blanc et ce qui est 
blanc devient noir. Les gris se voient attribuer leur transparence miroir. Cliquez à nouveau sur 
« Invert » (Inverser) pour désactiver la fonctionnalité. Exécute la même fonction que le bouton 
Invert (Inverser). Voir section 6.4.1 et Figures 6.4.3 et 6.4.4. 

 

Magnify (Agrandir) 
L’option « Magnify » (Agrandir) permet à l’utilisateur d’agrandir une zone d’intérêt. Pour utiliser 
la fonctionnalité « Magnify » (Agrandir), placez le curseur de la souris sur la zone à agrandir et 
cliquez avec le bouton gauche de la souris. La région d’intérêt est alors agrandie. Cliquez à 
nouveau sur « Magnify » (Agrandir) pour désactiver la fonctionnalité. Voir Figure 6.4.23. 
L’utilisateur peut ajuster la taille de la région d’intérêt agrandie. Voir le sous-menu « Magnifier 
Size » (Taille de la loupe) à la Section 6.4.3. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Edge Enhance (Rehaussement des contours) 
L’outil « Edge Enhance » (Rehaussement des contours) produit une définition plus nette des 
contours des régions présentant une différence de contraste. D’une manière générale, le 
rehaussement des contours peut amplifier les interférences des images. En sélectionnant à 
nouveau cette option du menu, vous désactivez le rehaussement des contours. Le fait de 
cliquer sur « Original Contrast » (Contraste d’origine) permet également de rétablir l’image à 
son état d’origine. Notez qu’il s’agit d’une fonctionnalité différente de la fonctionnalité 
« Enhance Image » (Rehaussement de l’image) des sections 6.4.1 et 6.4.3. 

ROI Contrast (Contraste de la RI) 
L’outil « ROI Contrast » (Contraste de la RI) permet d’optimiser les niveaux de contraste dans 
une région d’intérêt (RI) définie par l’utilisateur. Après avoir sélectionné « ROI Contrast » 
(Contraste de la RI), cliquez et maintenez le bouton gauche de la souris enfoncé au point de départ 
de la RI souhaitée, faites glisser la souris et relâchez le bouton de la souris au point final souhaité 
de la RI. Le contraste s’ajuste automatiquement aux meilleurs niveaux pour cette RI. 

ROI Window Level (Niveau de fenêtre de la RI) 
L’outil « ROI Window Level » (Niveau de fenêtre de la RI) n’est pas disponible dans la version 
actuelle du logiciel Vision. 

 
 
 
 
 

 
Figure 6.4.23 
Magnify (Agrandir) 
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Ruler (Règle) 
L’outil « Ruler » (Règle) permet à l’utilisateur de mesurer la distance entre deux points dans 
l’image affichée. Les mesures de longueur sont en millimètres (mm). Après avoir sélectionné 
« Ruler » (Règle), cliquez et maintenez le bouton gauche de la souris enfoncé au point de 
départ de la mesure, faites glisser la souris et relâchez le bouton de la souris au point de la fin 
de la mesure. La règle s’affiche sous la forme d’une ligne rouge sur l’image. 

La mesure (en mm) est affichée 
à l’extrémité de la règle. La règle 
demeure active jusqu’à ce que 
l’utilisateur sélectionne un autre 
outil d’image ou jusqu’à ce 
qu’une autre action soit 
effectuée. Voir Figure 6.4.24. 
Cliquez à nouveau sur « Ruler » 
(Règle) pour désactiver la 
fonctionnalité. 

 
Astuce : pour obtenir une ligne 
parfaitement horizontale, 
verticale ou une ligne à un angle 
parfait de 45 degrés, maintenez 
la touche MAJ (sur le clavier) 
enfoncée tout en maintenant le 
bouton gauche de la souris 
enfoncé et en faisant glisser la 
souris. 

 
 

ROI Statistics (Statistiques de la RI) 
L’outil « ROI Statistics » (Statistiques de la RI) affiche une boîte de dialogue contenant les 
statistiques de l’image. Cliquez et maintenez le bouton gauche de la souris enfoncé sur la 
région d’intérêt (RI) de l’image principale, faites glisser le curseur autour de la région que vous 
souhaitez sélectionner, puis relâchez le bouton de la souris. Les informations statistiques 
s’affichent du côté gauche de la boîte de dialogue pour la région sélectionnée et du côté droit 
de la boîte de dialogue pour l’image entière. Les statistiques affichées sont les suivantes : les 
points du début et de la fin de la RI, les valeurs d’intensité minimale, maximale et moyenne et 
l’écart-type (ET). Pour fermer la fenêtre d’informations statistiques, cliquez sur le bouton 
Close (Fermer). Voir Figure 6.4.25. Cliquez à nouveau sur « ROI Statistics » (Statistiques de 
la RI) pour désactiver la fonctionnalité. 

6.4.5 Suite 
 
 

 
Figure 6.4.24 
Ruler (Règle) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 6.4.25 
ROI Statistics (Statistiques de la RI) 
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ROI Histogram (Histogramme de la RI) 
L’outil « ROI Histogram » (Histogramme de la RI) crée un histogramme pour la RI définie 
par l’utilisateur. Après avoir sélectionné l’option du menu, placez le curseur de la souris 
dans l’image affichée, appuyez sur le bouton gauche de la souris et maintenez-le enfoncé, 
puis faites glisser le curseur pour sélectionner la RI souhaitée. Relâchez le bouton de la 
souris. Les histogrammes de la RI sélectionnée s’affichent. Voir Figure 6.4.26. 

La courbe noire représente l’histogramme de la région sélectionnée. La courbe bleue 
représente l’histogramme de l’image entière. Les deux courbes sont normalisées par 
rapport à la valeur maximale de pixel de la région d’intérêt sélectionnée. Cliquez à nouveau 
sur « ROI Histogram » (Histogramme de la RI) pour désactiver la fonctionnalité. 

 

 
 
 

ROI Profile (Profil de la RI) 
L’outil « ROI Profile » (Profil de la RI) crée un profil pour la RI définie par l’utilisateur. Après 
avoir sélectionné l’option du menu, placez le curseur dans l’image affichée. Maintenez le 
bouton gauche de la souris enfoncé et déplacez le curseur sur l’image, pour dessiner un 
cadre défini par l’utilisateur autour de la RI souhaitée. Relâchez le bouton gauche de la 
souris et un profil de la valeur de chaque pixel de la RI définie s’affiche. Voir Figure 6.4.27. 
Par défaut, les valeurs moyennes de la RI sélectionnée sont calculées sur l’axe court. Il est 
possible de changer l’axe en sélectionnant le bouton « SWITCH, HOR<->VERT » 
(BASCULER, HOR.<->VERT.). Cliquez à nouveau sur « ROI Profile » (Profil de la RI) pour 
désactiver la fonctionnalité. 

6.4.5 Suite 
 
 
 
 
 

 

 
Figure 6.4.26 
ROI Histogram (Histogramme de la 
RI) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 6.4.27 
ROI Profile (Profil de la RI) 
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Line Profile (Profil de ligne) 
L’outil « Line Profile » (Profil de ligne) affiche un profil pour une ligne définie par l’utilisateur. 
Après avoir sélectionné « Line Profile » (Profil de ligne), placez le curseur dans l’image 
affichée. Maintenez le bouton gauche de la souris enfoncé et déplacez le curseur sur 
l’image pour tracer une ligne définie par l’utilisateur. Relâchez le bouton gauche de la 
souris pour afficher un profil indiquant la valeur de chaque pixel de la ligne définie. Voir 
Figure 6.4.28. Par défaut, le premier point sélectionné est toujours la partie la plus à 
gauche (près de l’origine) du graphique (c’est-à-dire que l’axe horizontal du graphique peut 
avoir des indices de pixels (i,j) croissants ou décroissants, selon les points de départ/fin 
sélectionnés). Cliquez à nouveau sur « Line Profile » (Profil de ligne) pour désactiver la 
fonctionnalité. 

 

 
Niveau de fenêtre intégré 

Le logiciel Vision est livré avec une fonction de niveau de fenêtre « intégrée ». Il n’y a 
aucun bouton ou option du menu pour la sélectionner. La fonctionnalité « Window Level » 
(Niveau de fenêtre) est activée automatiquement chaque fois qu’une image est acquise ou 
récupérée de la base de données à des fins d’examen. Cette fonctionnalité permet à 
l’utilisateur de régler les niveaux de contraste et de luminosité de l’image à l’aide du 
curseur de la souris. 

Cliquez sur le bouton gauche de la souris et maintenez-le enfoncé sur l’image affichée, 
puis déplacez le curseur vers le haut ou vers le bas pour régler les niveaux de luminosité et 
d’obscurité. Vous pouvez également déplacer le curseur vers la gauche ou la droite pour 
un contraste faible ou élevé. Déplacez le curseur jusqu’à ce que l’image atteigne les 
niveaux souhaités. 

6.4.5 Suite 
 
 
 
 
 
 

Figure 6.4.28 
Line Profile (Profil de ligne) 
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En appuyant sur le bouton situé en bas de la fenêtre d’acquisition d’images (voir 
Figure 6.5.1), la bande des vignettes d’images du patient actuel s’affiche. Voir Figure 6.5.2. 

 
 

 

 
 

 
 
 
 

La bande de vignettes affiche la date de la procédure pour chaque série d’images, en texte 
orange dans la partie supérieure. 

L’image actuelle affichée dans la fenêtre d’acquisition d’images est surlignée en vert. 

La bande des vignettes est compatible avec les opérations de glisser-déposer, pour placer 
les images dans la zone d’affichage des images ou dans les fenêtres de révision, selon les 
besoins. 

De plus, l’utilisateur peut sélectionner plusieurs images d’un simple clic, puis choisir parmi 
différentes options pour enregistrer les images sur une clé USB, envoyer les images au 
PACS ou supprimer les images. Les images sélectionnées sont surlignées en orange. 

Des flèches sont affichées à gauche et à droite de l’écran. Si plusieurs images sont prises, 
l’utilisateur peut parcourir les images par date croissante en appuyant sur les flèches 
gauche/droite. 

De plus, l’option Open the Database (Ouvrir la base de données) (voir Figure 6.5.3) 
permet de passer en mode Révision. Ce bouton équivaut à appuyer sur Review Mode 
(Mode Révision) dans le Menu d’accueil. Voir Figures 6.0.1 et 6.6.1. 

6.5.0 
Navigateur des 
images du patient 
actuel 
Figure 6.5.1 
Icône du navigateur des 
images du patient actuel 
 
Figure 6.5.2 
Navigateur des images du 
patient actuel 

 
 
 
 

Figure 6.5.3 
Bouton de la base de données 
d’images 
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Vous pouvez accéder au mode de révision en cliquant sur le bouton Review (Révision) dans 
le menu d’accueil, Figures 6.6.1 et 6.0.1, ou sur le bouton Open 
Database (Ouvrir la base de données) ans le navigateur d’images du 
patient actuel. Voir Figure 6.5.3 ci-dessus. Cliquez sur l’un de ces 
boutons pour ouvrir la base de données (voir Figure 6.6.2). Le système 
reste en veille dans le mode de révision. 

 
 

 
La base de données est essentiellement composée de trois sections, ou sous-fenêtres. La 
section Tableau de Liste des patients, en haut, la section Tableau de Liste des procédures, 
au milieu, et la section Liste/visionneuse des vignettes d’images, située au bas. 

6.6.0 
Base de données 
Figure 6.6.1 
Icône du mode de révision 
affichée dans le menu 
d’accueil. 

 
 
 
 
 
 

Figure 6.6.2 
Base de données d’images 
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Les tableaux des listes fonctionnent selon une hiérarchie descendante, comme indiqué par la 
flèche : 
Liste des patients--->Liste des procédures --->Liste/visionneuse des vignettes d’images. 
Lorsqu’un champ Patient est sélectionné, la fenêtre de procédure devient active. La fenêtre 
de procédure affiche la liste de toutes les procédures effectuées pour le patient sélectionné. 
De plus, toutes les images du patient sont affichées en bas à droite. 
Lorsqu’une procédure est sélectionnée, la liste/visionneuse des vignettes d’images est filtrée 
pour afficher uniquement les images correspondant à la procédure sélectionnée. Vous 
pouvez sélectionner plusieurs procédures en maintenant la touche Maj enfoncée et en 
cliquant sur chaque procédure avec le bouton gauche de la souris. Toutes les images des 
procédures sélectionnées seront affichées en conséquence. 
Le tri de la base de données peut être réglé en cliquant sur les champs supérieurs, tels que 
l’ID du patient et le nom de famille, pour trier selon l’un ou l’autre des critères. Lorsque vous 
cliquez sur l’un des champs de la base de données avec le curseur de la souris, une petite 
flèche s’affiche dans le champ. Lorsque l’on utilise le bouton de gauche de la souris et que 
l’on sélectionne le champ à nouveau, le dessin de la flèche passe d’ascendant à descendant 
ou inversement. Le champ sélectionné est automatiquement trié en conséquence. 
La base de données affiche des barres de défilement pour faciliter la navigation. 
La liste/visionneuse des vignettes d’images permet à un utilisateur de cliquer sur le symbole 
« + » pour ajouter automatiquement l’image à une fenêtre de révision. Un utilisateur peut 
ajouter jusqu’à quatre images dans les fenêtres de révision. Les fenêtres de révision sont 
ajustées automatiquement pour englober les quatre images. 
Les mêmes options que celles disponibles dans le navigateur d’images du patient actuel (voir 
Figure 6.5.2) se trouvent également en haut de la page de base de données. De plus, des 
options supplémentaires sont décrites à la section 6.6.1. 
Remarque importante : les vignettes des images (.PNG) sont des fichiers distincts des 
fichiers de données d’images (DCM, DAT, DMM ou RAW). Elles portent le même nom de 
fichier que le fichier d’image, mais leur extension de fichier est différente (.PNG). Il est 
possible d’avoir un fichier d’images sans « vignette ». Dans ce cas, le logiciel Vision tente de 
créer automatiquement une vignette pour charger l’image dans la base de données. 
Cependant, si cette opération échoue, l’image ne s’affiche pas. 

 

Save Image(s) (Enregistrer la/les image(s)) 
Le bouton Save image(s) (Enregistrer la/les image(s)) devient disponible lorsqu’une entrée 
du tableau des images ou de la liste des vignettes est sélectionnée, ou qu’une image du 
patient actuel est sélectionnée, sinon il est désactivé. L’image sélectionnée peut être 
enregistrée dans les formats d’image 8 bits les plus populaires suivants : JPEG, BMP, TIFF et 
RAW. Elle peut également être enregistrée en format TIFF de 16 bits. 
Le niveau de fenêtre de l’image enregistrée est le niveau de fenêtre par défaut. Si l’utilisateur 
souhaite que le niveau de fenêtre soit modifié, il doit charger l’image dans « Image View » 
(Vue d’image) et l’imprimer à partir de cet emplacement, plutôt que de l’imprimer à partir de la 
boîte de dialogue de la base de données. 

 
Send Image(s) to PACS (Envoyer une/des image(s) au PACS) : 

Cette fonctionnalité envoie une ou des images à un serveur DICOM PACS préconfiguré. 
Veuillez consulter la section 6.7.0 pour obtenir plus d’informations. 

 
Fonctions et outils du menu de la base  

de données d’images 
Il existe des fonctions permettant de naviguer et d’effectuer 
des recherches dans la base de données, ainsi que de 
modifier, supprimer et ajouter des enregistrements à la base de 
données. Ces fonctions sont décrites dans les options de menu 
de la base de données. Elles sont accessibles à partir du 
bouton du haut intitulé Additional Options (Options 
supplémentaires) dans la base de données. 

6.6.0 Suite 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

6.6.1 
Options 
supplémentaires de 
la base de données 

Figure 6.6.3 
Menu Additional Options (Options 
supplémentaires) 
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Menu Open (Ouvrir) 
Le menu « Open » (Ouvrir) affiche uniquement l’option « Open Image from File » (Ouvrir une 
image à partir d’un fichier). Elle ouvre une boîte de dialogue de Windows qui permet à l’utilisateur 
de naviguer dans les lecteurs locaux ou d’un réseau pour ouvrir des fichiers d’images. 

6.6.1 Suite 

Menu Print (Imprimer) 
Le menu « DB-PRINT » (IMPRIMER LA BD) offre des fonctionnalités d’impression par image, 
par procédure et par patient. Voir Figure 6.6.4. 

 
 
 
 
 
 
 
 

 
Print Image to Local Printer (Imprimer l’image sur une 

imprimante locale) 
L’option « Print Image to Local Printer » (Imprimer l’image sur une imprimante locale) devient 
disponible lorsqu’une entrée du tableau des images ou de la liste des vignettes est 
sélectionnée, sinon elle est désactivée. L’image sélectionnée est imprimée avec l’imprimante 
locale par défaut du système Windows. 

Le niveau de fenêtre de l’image imprimée est le niveau de fenêtre par défaut. Il n’est pas 
recommandé aux utilisateurs d’imprimer à partir de ce menu, à moins qu’ils ne soient 
satisfaits des impressions définies sur les niveaux de fenêtre par défaut calculés par le 
programme. L’utilisateur peut d’abord charger l’image dans la fenêtre « Image View » (Vue 
d’image) (Révision), puis régler l’image aux niveaux de fenêtre souhaités. Lorsqu’il est 
satisfait du niveau de la fenêtre, l’utilisateur peut alors lancer l’impression à partir du menu de 
la fenêtre Image View (Vue d’image). Une boîte de dialogue « Format Options » (Options de 
formats) permet de choisir le format d’impression. 

 
Print Image(s) to DCM Printer (Imprimer la/les images sur une 

imprimante DCM) 
Cette fonction envoie la/les images à une imprimante DICOM préconfigurée. 
 

Menu View (Affichage) 
Le menu « View » (Affichage) offre à l’utilisateur un certain nombre d’options pour l’affichage 
de la base de données. Voir Figure 6.6.5. 

 
 
 
 
 
 
 
 
 

 
Show All DB Entries (Afficher toutes les entrées de la BD) 

Recharge le tableau de la liste des patients à partir du fichier de la base de données. Tout 
nouveau changement ou ajout à la base de données est appliqué au tableau. Cette sélection 
efface également tout « Search Filter » (Filtre de recherche) actif qui aurait pu être appliqué 
aux tableaux. L’outil « Search Filter » (Filtre de recherche) est expliqué en détail dans la 
section Recherche dans la base de données ci-dessous. 

 

 
Figure 6.6.4 
Menu Print (imprimer) de la base de 
données 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
 

Figure 6.6.5 
Menu View (Affichage) de la base de 
données 
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Refresh DB Entries (Actualiser les entrées de la BD) 
Actualise le tableau de la liste des patients, mais conserve tout « Search Filter » (Filtre de 
recherche) existant qui a été appliqué. 

 
Browse Data Directory (No DB) (Parcourir le répertoire de 

données - aucune BD) 
Affiche toutes les vignettes d’images dans le répertoire des données établi par le fichier de 
configuration. Ces fichiers sont affichés dans la visionneuse de vignettes. Ils ne sont associés 
ni à la base de données, ni aux listes de tableaux. Cet outil est utile pour examiner les images 
non enregistrées ou pour résoudre les problèmes de base de données lorsque des images 
sont présentes dans le répertoire de données actuel. 

 
Browse Any Directory (No DB) (Parcourir n’importe quel 

répertoire - aucune BD) 
Permet à l’utilisateur de naviguer dans n’importe quel répertoire de fichiers. Ces fichiers sont 
affichés dans la visionneuse de vignettes. Ils ne sont associés ni à la base de données, ni 
aux listes de tableaux. Cet outil est utile pour examiner un répertoire d’images qui n’a jamais 
été enregistré dans la base de données ou lorsque les enregistrements de la base de 
données sont corrompus. 

 
Menu Search (Rechercher) 

L’outil « Search » (Recherche) dans la base de données (voir Figure 6.6.6) permet d’effectuer 
des recherches détaillées ou de filtrer la base de données. En sélectionnant le menu « DB-
Search » (Recherche dans la BD), une recherche détaillée et spécifique peut être effectuée. 
Lorsqu’un critère de recherche est saisi et activé dans la boîte de dialogue « DB-Search » 
(Recherche dans la BD), voir Figure 6.6.7, le filtre de recherche est appliqué à tous les 
tableaux de listes de la boîte de dialogue « Image Database » (Base de données d’images). 
Le critère de recherche activé est appelé « Search filter » (Filtre de recherche) et ce filtre 
demeure actif jusqu’à ce que l’utilisateur sélectionne « Stop Search » (Arrêter la recherche) 
dans le menu « DB-Search » (Recherche dans la BD) ou « Show All DB Entries » (Afficher 
toutes les entrées de la BD) dans le menu « DB-
View » (Vue de la BD). Le « Search Filter » 
(Filtre de recherche) actif est toujours affiché 
dans la légende de la boîte de dialogue de la 
base de données d’images. 

 
 
 
 
 
 

Start search (Démarrer la recherche) 
La fonctionnalité « Start search » (Démarrer la recherche) ouvre la boîte de dialogue « DB-
Search » (Recherche dans la BD) qui permet à l’utilisateur de placer un FILTRE DE 
RECHERCHE actif dans la base de données. Lorsque la boîte de dialogue « Search » 
(Recherche) est ouverte, la page « Database » (Base de données) se ferme et le logiciel revient à 
la page « Image Acquisition » (Acquisition d’images). La page « Database » (Base de données) 
s’ouvre automatiquement après la fermeture de la boîte de dialogue « Search » (Recherche). 

6.6.1 Suite 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figure 6.6.6 
Menu Database Search (Recherche 
dans la base de données) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Figure 6.6.7 
Démarrage d’une recherche dans la 
base de données 
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Les menus déroulants proposent des listes de catégories de recherche. Sélectionnez une 
catégorie de recherche et saisissez le paramètre de recherche souhaité pour lancer la 
recherche. Sélectionnez « Start » (Démarrer) pour lancer la recherche. Si une catégorie 
contient plus d’une entrée distincte, alors toutes les entrées de cette catégorie s’affichent. 

Stop Search (Arrêter la recherche) 
L’option « Stop Search » (Arrêter la recherche) désactive tous les filtres de recherche actifs, 
efface tous les tableaux de listes et recharge la liste de tous les patients dans le tableau de la 
liste des patients. 

Menu Tools (Outils) 
Le menu « DB-Tools » (Outils de la BD) propose des fonctions par image, par procédure, par 
patient, ainsi que des fonctions 
utiles pour réparer ou reformater la 
base de données. 

 

 

 

 
 

 

 
Edit Image Record (Modifier un enregistrement d’image) 

La fonction « Edit Image Record » (Modifier un enregistrement d’image) n’est actuellement 
pas disponible dans le logiciel Vision. 
 

Add Record to DB (Ajouter un enregistrement à la BD) 
Disponible lorsque l’entrée à partir du Tableau des images ou de la Liste des vignettes est 
sélectionnée, sinon cette fonction est désactivée. Ceci est particulièrement utile lorsque l’on 
parcourt un répertoire alors que la base de données ne dispose d’aucune saisie pour les 
images dans ce répertoire. L’utilisateur peut sélectionner une seule image dans la liste des 
vignettes et ajouter des enregistrements de cette image dans la base de données. Si l’entrée 
existe déjà dans la base de données pour l’image sélectionnée, elle ne représente aucun 
danger, car elle peut uniquement mettre à jour l’emplacement actuel du fichier d’images dans 
la base de données, c’est-à-dire le nom du fichier/dossier. 

 
Import Records in DIR to DB (Importer des enregistrements du 

RÉP vers la BD) 
Cet outil permet de parcourir et de sélectionner un dossier, puis de remplir la base de 
données avec toutes les entrées correspondantes pour tous les fichiers d’images dans le 
répertoire sélectionné (y compris les sous-répertoires). Les formats d’images peuvent être 
DCM, DAT, DMM et RAW. Si des vignettes ou des images sont manquantes, cet outil génère 
également des vignettes en format BMP dans le même répertoire. 

 
Reformat All DB (Reformater toute la base de données) 

L’outil « Reformat All DB » (Reformater toute la base de données) permet de reformater les 
champs des tableaux « Date » [AAAA/MM/JJ] et « Date/Time » (Date/Heure) [AAAA/MM/JJ 
HH:MM:SS], et de mettre en majuscules les lettres des entrées de certains autres champs. 
Cet outil est utile lorsqu’un fichier de base de données plus ancien est importé et ouvert pour 
la première fois, ou lorsque l’utilisateur modifie manuellement les entrées de la base de 
données à l’aide de MS Access. 

6.6.1 Suite 

 

 

 

 
 

Figure 6.6.8 
Menu des outils de la base de 
données 
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Remarques supplémentaires sur la base de données 
• La possibilité de quitter la base de données tout en restant en mode Review (Révision) se 

trouve dans Additional Options (Options supplémentaires). 

• Le bouton en haut à gauche se règle automatiquement pour ramener l’utilisateur à 
l’acquisition ou au menu principal, ou bien il devient le bouton Close Database (Fermer 
la base de données), en fonction du flux de travail utilisé pour accéder à l’écran 
« Database » (Base de données) ou de l’action la plus appropriée. 

Modifier ou supprimer les informations sur le patient dans la base 
de données 

L’utilisateur peut modifier ou supprimer des informations sur le patient dans la base de 
données. Cliquez avec le bouton droit de la souris sur l’entrée du patient au haut de la base 
de données pour ouvrir une boîte de dialogue. Voir Figure 6.6.9. 

 

 
Cliquez sur « Edit Patient Information » (Modifier 
les informations sur le patient) pour ouvrir la 
boîte de dialogue « Patient Information » 
(Informations sur le patient). Voir Figure 
6.6.10. Cliquez sur Cancel (Annuler) pour revenir 
à la base de données sans effectuer ni enregistrer 
des modifications. Cliquez sur Save Changes 
(Enregistrer les modifications) pour ouvrir la boîte de dialogue de Confirmation. Cliquez sur 
Yes (Oui) pour confirmer et continuer. Les changements sont maintenant enregistrés et 
l’utilisateur est renvoyé à la base de données. No (Non) annule les modifications et renvoie 
l’utilisateur à la base de données. Cliquez sur Cancel (Annuler) pour retourner à la boîte de 
dialogue « Patient Information » (Informations sur le patient). 

 Remarque : si le système possède un mot de passe de démarrage activé (voir la 
description de l’utilitaire de connexion à la Section 6.4.4 et la Figure 6.4.21), le même mot de 
passe est demandé lors de la tentative de « Delete Patient Information » (Suppression des 
informations sur le patient) de la base de données. 

 

La norme DICOM  
Qu’est-ce que la norme DICOM? 

La norme DICOM (Digital Imaging and Communications in Medicine) est une série de 
protocoles utilisés par les équipements et logiciels médicaux, pour rendre les données 
compatibles et interchangeables avec d’autres équipements ou logiciels médicaux. 

Lorsqu’un fichier est enregistré dans un format DICOM, un fichier 
est créé. Celui-ci comprend les données pertinentes du patient, 
les données de l’équipement d’imagerie et du matériel, ainsi que 
les données d’image, le tout dans un seul fichier. De plus, le 
fichier enregistré contient des caractéristiques spécifiques qui 
permettent à l’ordinateur et au logiciel de l’identifier comme étant 
un fichier conforme à la norme DICOM. Une fois qu’une application 
logicielle reconnaît le fichier comme un fichier conforme à la norme 
DICOM, elle peut lancer un lecteur DICOM et extraire les données 
correctement, quelle que soit l’origine du fichier. 

 
Un fichier créé avec le protocole DICOM a la structure suivante : 

6.6.1 Suite 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 6.6.9 
Boîte de dialogue Edit/Delete 
(Modifier/Supprimer) (gauche) 

Figure 6.6.10 
Patient Information (Informations sur 
le patient) (droite) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6.7.0 
Fonctionnalité 
DICOM 

 
 
 
 

Figure 6.7.1 
Structure du protocole DICOM 
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Lorsque le préambule comprend 128 octets, ils sont habituellement tous définis sur 00H, sauf 
s’il n’est pas utilisé par un profil d’application ou une implémentation spécifique. Le préfixe 
comprend 4 octets constituant la chaîne de caractères « DICM » encodée en lettres 
majuscules du répertoire de caractères ISO 8859 G0. Les éléments de données sont 
arbitrairement grands (ou petits) et contiennent les données. 

Modalité 
Les paramètres d’un fichier DICOM pour la « Modality » (Modalité) sont accessibles à partir de 
la barre de menu supérieure en sélectionnant « DICOM Utilities » (Utilitaires DICOM), puis 
« DICOM Modality Setup » (Configuration de modalité DICOM). 

 
 

Le type de stockage DICOM, « Presentation » (Présentation) ou « Processing » (Traitement), 
peut être sélectionné. La même boîte de dialogue permet de sélectionner la modalité d’image 
DICOM, soit radiographie numérique ou mammographie numérique. Les paramètres 
« Transfer Syntax » (Syntaxe de transfert) et « Value Representation » (Représentation de la 
valeur) ne peuvent pas être définis par l’utilisateur. Ils sont toujours réglés sur META 
HEADER PRESENT, LITTLE_ENDIAN et VR_IMPLICIT. 

 

6.7.0 Suite 
 
 
 
 
 

Figure 6.7.2 
Menu DICOM Utilities (Utilitaires 
DICOM) 

 
 
 
 
 
 
 

 
Figure 6.7.3 
Paramètres de modalité 
DICOM par défaut illustrés 
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 REMARQUE : une fois les modalités DICOM sélectionnées, elles demeurent actives, 

même après la fermeture du logiciel Vision. Les paramètres de modalité 
sont stockés et restent configurés jusqu’à ce qu’ils soient modifiés à 
nouveau à l’aide des paramètres de fichier DICOM. Ces paramètres 
(type et modalité de stockage, syntaxe de transfert et représentation de 
la valeur) seront effectifs pour toutes les fonctionnalités DICOM locales 
d’enregistrement et d’impression. 

 

Default DICOM Servers (Serveurs DICOM par défaut) 
Cette section contient les paramètres par défaut des serveurs DICOM et permet d’automatiser 
certains processus lors du stockage, de l’impression ou de la recherche sur les serveurs 
PACS et MWL. 

Les cases à cocher « Enable Single-Click Auto Store » (Activer le stockage automatique en un 
seul clic), « Print » (Imprimer) ou « MWL Connection » (Connexion MWL) permettent à l’utilisateur 
de stocker ou d’imprimer des images ou de se connecter automatiquement au serveur MWL. Si 
vous utilisez un seul serveur PACS pour ces actions ou si la majorité de votre travail concerne un 
seul serveur PACS, cochez la case souhaitée pour automatiser ces actions. 

La case « Enable Auto Search When Connecting to MWL Server » (Activer la recherche 
automatique lors de la connexion au serveur MWL) indique à l’application d’effectuer 
automatiquement une recherche avec les paramètres de recherche par défaut lors de la 
recherche des données du patient. 

La case « Auto close dialog after N seconds of successful transfer/printing » (Fermeture 
automatique de la boîte de dialogue après N secondes de transfert/impression réussi(e)) 
ferme automatiquement la boîte de dialogue du réseau DICOM après un nombre de secondes 
spécifié. La boîte de dialogue ne se ferme pas automatiquement en cas d’erreur de transfert 
ou d’impression. 

Cliquez sur le bouton DICOM Servers (Serveurs DICOM) pour ouvrir la boîte de dialogue 
« DICOM Networking » (Réseau DICOM), dans laquelle l’utilisateur peut ajouter, modifier ou 
supprimer des serveurs DICOM. Voir Figure 6.7.5. 

 
DICOM Save Local (Enregistrement DICOM local) 

Cette fonction permet d’enregistrer l’image actuelle sur un lecteur/répertoire local en cliquant 
avec le bouton droit de la souris n’importe où dans l’image. La boîte de dialogue présentée à 
la Figure 6.7.4 ci-dessous s’affiche. Cliquez sur « Save/Store current image » 
(Enregistrer/stocker l’image actuelle) puis sur « As local DICOM image » (comme image 
DICOM locale). La boîte de dialogue de sauvegarde de fichiers Windows standard s’affiche. 
Parcourez ou cliquez sur le répertoire/dossier souhaité, saisissez le nom du fichier et cliquez 
sur Save (Enregistrer). 

 

 

6.7.0 Suite 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

 

 

 

 

 
Figure 6.7.4 
Boîte de dialogue Save Current 
Image (Enregistrer l’image actuelle) 
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PACS Store (Stockage PACS) et PACS Print (Impression PACS) 

Le logiciel Vision permet un stockage PACS (DICOM) et une impression PACS (DICOM). Ces 
options sont disponibles dans l’ensemble du logiciel. Par exemple, si le bouton PACS Store 
(Stockage PACS) est sélectionné, la boîte de dialogue « DICOM Networking Dialog » (Boîte 
de dialogue réseau 
DICOM) ci-dessous 
peut s’afficher. Cette 
boîte de dialogue 
permet à l’utilisateur 
d’effectuer un 
stockage DICOM ou 
une impression 
DICOM, ainsi que 
d’ajouter, de modifier 
ou de supprimer des 
connexions réseau 
ou des périphériques 
DICOM. 

 

 

 

PACS DICOM Store (Stockage PACS DICOM) 
Le logiciel Vision prend en charge le service DICOM 3.0 C-STORE. Ceci permet d’envoyer 
une image ou une série d’images (selon une procédure spécifiée) à un système de stockage 
distant conforme à l’entité d’application (EA) DICOM, comme le PACS. Encore une fois, la 
fonction DICOM Store (Stockage DICOM) est accessible dans l’ensemble du logiciel Vision. 
Les modifications de la présentation et du traitement peuvent être effectuées par le biais de la 
configuration de la modalité DICOM, dans le menu « Tools » (Outils). 

 Remarque : pour le stockage DICOM, la case « SET FILM Attributes » (DÉFINIR les 
attributs DU FILM) est affichée en gris. 

L’utilisateur peut ajouter une nouvelle configuration pour une entité d’application DICOM (EA 
DICOM) distante à laquelle envoyer l’image ou choisir parmi une configuration déjà existante, 
affichée dans les connexions réseau DICOM, dans la boîte de dialogue « DICOM Networking 
Dialog » (Boîte de dialogue réseau DICOM). En double-cliquant (ou avec un seul clic et en 
appuyant sur le bouton Connect) sur l’icône de l’EA DICOM distante, le logiciel Vision se 
connecte et établit une association DICOM avec l’EA distante sélectionnée. Une fois 
l’association réussie, l’image peut être envoyée pour être stockée en appuyant sur le bouton 
Store (Stocker). Une fois le bouton Store (Stocker) sélectionné, le logiciel Vision envoie 
l’image sélectionnée à l’EA DICOM distante définie. Si l’opération de stockage réussit, l’EA 
DICOM distante envoie une confirmation de réception et de stockage de la ou des images. Si 
l’opération échoue, l’EA DICOM distante envoie un code d’erreur indiquant la raison de l’échec. 

Une seule image peut également être envoyée pour être stockée en cliquant avec le bouton 
droit de la souris sur la « vignette » de l’image (dans le navigateur de la base de données) et 
en suivant la même procédure que celle décrite précédemment. Il est possible d’envoyer toute 
une série (procédure) d’images pour être stockées. Pour ce faire, cliquez avec le bouton droit 
de la souris sur le nom de la série (Procédure) affiché dans l’écran du navigateur de base de 
données, puis suivez le même protocole que celui décrit ci-dessus. 

 
 

6.7.0 Suite 
 
 
 

Figure 6.7.5 
Boîte de dialogue DICOM 
Networking (Réseau DICOM) 
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Add Session (Ajouter une session) 
Le bouton Add Session (Ajouter une session) ouvre la boîte de dialogue Session dans 
laquelle l’utilisateur peut configurer une nouvelle connexion à une entité d’application 
DICOM distante. 

Pour créer une nouvelle configuration de connexion à une EA DICOM distante, l’utilisateur 
doit disposer des informations suivantes : le titre de l’entité d’application (titre de l’EA), le 
choix de la « fonction à exécuter » DICOM/PACS, l’adresse IP et le numéro de port du 
serveur (c’est-à-dire, de l’imprimante DICOM ou du système PACS). 

Le titre d’EA et le numéro de port du système de l’utilisateur (c’est-à-dire, le client) sont 
également nécessaires. Remplissez les champs de données correspondants et sélectionnez 
OK pour créer une nouvelle configuration. 

 
Choix du comportement de la fonction de session DICOM/PACS 

par défaut 
Il existe actuellement quatre (4) types de fonctions qu’une session DICOM peut utiliser par 
défaut. Celles-ci se trouvent dans la liste déroulante « Function » (Fonction) (case combinée) 
présentée dans la Figure 6.7.6 ci-dessous. 
Les types de fonctions sont les suivants :  

1. Connexion GENERAL (GÉNÉRALE) 
DICOM/PACS 

2. Connexion DICOM STORE (STOCKAGE 
DICOM) 

3. Connexion PRINTER (IMPRIMANTE) 
DICOM 

4. Connexion WORKLIST (LISTE DE 
TRAVAIL) de la modalité DICOM 
 

 

 

Le but de la « fonction » DICOM est de permettre la création (l’ajout) d’une session/connexion qui 
permet d’utiliser un « dispositif » DICOM/PACS uniquement lorsque l’utilisateur l’a 
configuré pour une catégorie de fonctions particulières. Une fois configuré, lorsque vous 
affichez ou utilisez la « DICOM Networking Dialog » (Boîte de dialogue réseau DICOM) 
(voir Figure 6.7.5), seule l’icône correspondant à la fonction choisie sera « active et 
allumée ». C’est-à-dire qu’elle aura une couleur bleue plutôt qu’une couleur « grisée ». Par 
exemple, la Figure 6.7.5 montre trois (3) icônes représentant, dans l’ordre, un stockage 
PACS (DICOM Store 1), une impression PACS (DICOM Print 1) et une liste de travail de 
modalité (DICOM-MWL). Comme l’icône DICOM Store (Stockage DICOM) a été 
sélectionnée précédemment, elle est la seule à être active (écran bleu). Les autres modes 
fonctionnent de la même manière. 

 
Modify Session (Modifier la session) 

Le bouton Modify Session (Modifier la session) ouvre la boîte de dialogue de l’EA DICOM 
sélectionnée. Dans cette fenêtre, l’utilisateur peut modifier les informations du serveur et du 
client indiquées dans la section « Add Session » (Ajouter une session). 

 

6.7.0 Suite 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 6.7.6 
Boîte de dialogue Session Properties 
(Propriétés de la session) 
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Remove Session (Supprimer la session) 
Le bouton Remove Session (Supprimer la session) supprime la configuration de l’EA 
DICOM sélectionnée du logiciel Vision. Une fois supprimée, une configuration de l’EA 
DICOM ne peut pas être restaurée, à moins que l’utilisateur ne saisisse à nouveau 
manuellement les données requises en utilisant le bouton « Add Session » (Ajouter une 
session). Une confirmation de l’action sera demandée (voir ci-dessous). 

Association 
Le bouton Association List (Liste des associations) ouvre la boîte de dialogue « DICOM 
Association » (Association DICOM) montrée ci-dessous, dans laquelle l’utilisateur peut 
modifier les paramètres et protocoles utilisés par le logiciel Vision lors de la négociation d’une 
connexion avec une EA DICOM distante. Ces options doivent être modifiées uniquement par 
un utilisateur avancé, familiarisé avec les protocoles d’association DICOM. 

 

 

6.7.0 Suite 
 

 
 
 
 
Figure 6.7.7 
Vérification de la suppression d’une 
connexion réseau DICOM existante 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 6.7.8 
Fenêtre DICOM Association 
(Association DICOM) 
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Attributs du film 

La sélection de « Set DICOM Print Film Attributes » (Définir les attributs d’impression de film 
DICOM) dans le menu « Command » (Commande) (Figure 6.7.9) affiche la boîte de dialogue 
DICOM Printer Setup (Configuration de l’imprimante DICOM). Voir Figure 6.7.10. Dans cette 
boîte de dialogue, l’utilisateur peut sélectionner différentes options régissant le film et le 
format d’impression. La sélection de l’option Default (Par défaut) rétablit toutes les options 
par défaut. La configuration des 
paramètres est effectuée avec les 
menus déroulants. Pour accepter la 
configuration modifiée, sélectionnez 
OK. Pour rejeter les options et quitter 
la boîte de dialogue sans apporter 
aucune modification, sélectionnez 
Cancel (Annuler). 

 

 
 
 
 
 
 
 
 
 

 

6.7.0 Suite 
 
 
 
 
 
 
 
 
Figure 6.7.9 
Set DICOM PRINT FILM Attributes 
(Définir les attributs d’impression de 
film DICOM) 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 6.7.10 
Boîte de dialogue DICOM Printer 
Setup (Configuration de l’imprimante 
DICOM) 
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Impression PACS 

L’option PACS Print (Impression PACS) envoie l’image sélectionnée à l’imprimante DICOM 
PACS sélectionnée. L’image est imprimée selon les options de format et d’impression de film 
spécifiées dans la boîte de dialogue « Set Film Attributes » (Configurer les attributs du film) 
décrite précédemment. Si l’utilisateur lance l’impression PACS à partir de « Image View » 
(Vue d’image), le niveau de fenêtre sera choisi dans « Image View » (Vue d’image). Si 
l’impression PACS est lancée à partir de la boîte de dialogue « Database » (Base de 
données), le niveau de fenêtre par défaut calculé par le logiciel Vision sera utilisé. 

 
Close (Fermer) 

Le bouton Close (Fermer) ferme la boîte de dialogue « DICOM Networking Dialog » (Boîte de 
dialogue réseau DICOM) et renvoie l’utilisateur à la zone à partir de laquelle la commande 
DICOM a été exécutée. Cette commande ferme également la connexion ou l’association entre 
le logiciel Vision et le périphérique DICOM distant si une connexion a été établie. 
 

Présentation 
La fonction « User Annotations » (Annotations de l’utilisateur) dans le logiciel Vision permet 
d’appliquer une « superposition » graphique transparente sur une image, communément 
appelée « annotation ». Ces annotations peuvent être un texte, des lignes, des lignes de 
« forme libre » (courbes de Bézier), des flèches, des ellipses et des cases. Cela permet 
d’ajouter des informations supplémentaires et des « marqueurs » sur l’image, au besoin. 
Notez que toutes les annotations peuvent être facilement activées ou désactivées, en d’autres 
termes, elles peuvent être affichées ou masquées à volonté. 

 
Fonctionnement 

Pour commencer l’annotation, sélectionnez l’outil Annotations dans le menu de gauche. Voir 
Figures 6.4.1 et 6.8.1. Lorsque cette boîte de dialogue est ouverte, le logiciel met 
immédiatement l’utilisateur en mode de conception. Il affiche également une 
« palette d’outils ». Voir Figure 6.8.2 ci-dessous. 

 

 
Le fait de sélectionner Save (Enregistrer) ou Cancel (Annuler) dans cette boîte de dialogue 
annule les annotations précédentes ou enregistre les annotations actuelles dans la fenêtre. 
Cela ramène également l’utilisateur au mode d’imagerie normal. 

La palette d’outils comprend les quinze (15) options d’outils suivantes. Cependant, l’utilisateur 
peut choisir d’afficher les 8 outils les plus courants, selon ses besoins, dans la ligne 
supérieure de la boîte de dialogue. 

Notez que le comportement de la plupart de ces options d’outils implique l’utilisation de la 
souris pour guider la position et la forme 
dynamiques à l’écran. Les « clics » de la 
souris sont utilisés pour définir les positions 
et les formes finales. 

Le terme « glisser » signifie que l’on 
maintient le bouton gauche de la souris 
enfoncé et que l’on déplace l’objet sur 
l’écran. Le fait de relâcher le bouton gauche 
de la souris ou de cliquer sur le bouton droit 
de la souris fixe l’annotation en position 
« permanente » ou finale. 

 

6.8.0 
Annotations de 
l’utilisateur 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 6.8.1 
Palette d’outils de 
conception des annotations 
de l’utilisateur 

 
 
 
 
 
 
 
 
 

Figure 6.8.2 
Palette d’outils de 
conception des annotations 
de l’utilisateur 
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Le texte suivant présente une description de chaque option d’outil en commençant par le coin 
supérieur gauche de la figure ci-dessus. 

1. Outil de sélection : cette option permet de sélectionner (surligner) l’objet d’annotation en 
cours. Cliquez sur le bouton gauche de la souris et maintenez-le enfoncé pour définir une 
position de départ, puis déplacez la souris. Les annotations contenues dans la boîte 
affichée seront sélectionnées pour une utilisation ultérieure. Relâchez le bouton gauche 
de la souris pour terminer l’opération. 

2. Outil de ligne : cette option permet de tracer une ligne droite. Le comportement de la 
souris est le même que ci-dessus. 

3. Outil de case : dessine une case. Le comportement de la souris est le même que ci-dessus. 
4. Outil Ellipse (et Cercle) : dessine une ellipse ou un cercle. Le comportement de la 

souris est le même que ci-dessus. 
5. Outil de flèche : cette option permet de tracer une ligne avec une flèche à son extrémité. 

Le comportement de la souris est le même que pour l’outil de ligne. 
6. Outil de ligne ouverte polygonale : trace des lignes non droites « ouvertes segmentées ». 

Cliquez sur le bouton gauche de la souris en le maintenant enfoncé, et dessinez. Relâchez le 
bouton gauche pour définir un segment de ligne. Répétez l’opération autant de fois que 
désiré. Cliquez sur le bouton droit de la souris pour terminer l’action de l’outil. 

7. Outil de texte : permet de créer une « zone de texte » dans laquelle l’utilisateur peut 
saisir des données sous forme de texte. 

8. Outil de règle : crée un segment de ligne tracée à la règle. Très similaire à la fonction 
Règle des outils d’image. 

9. Outil de ligne fermée polygonale : trace des lignes non droites « fermées segmentées ». 
Cliquez sur le bouton gauche de la souris en le maintenant enfoncé, et dessinez. 
Relâchez le bouton gauche pour définir un segment de ligne. Répétez l’opération autant 
de fois que désiré. Cliquez sur le bouton droit de la souris pour terminer l’action de l’outil. 

10. Outil de ligne ouverte courbe : trace des lignes courbes « ouvertes segmentées ». 
(Courbes de Bézier.) Cliquez sur le bouton gauche de la souris en le maintenant enfoncé, 
et dessinez. Relâchez le bouton gauche pour définir un segment de ligne courbe. 
Répétez l’opération autant de fois que désiré. Cliquez sur le bouton droit de la souris pour 
terminer l’action de l’outil. 

11. Outil de ligne fermée courbe : trace des lignes courbes « fermée segmentées ». 
(Courbes de Bézier.) Cliquez sur le bouton gauche de la souris en le maintenant enfoncé, 
et dessinez. Relâchez le bouton gauche pour définir un segment de ligne courbe. 
Répétez l’opération autant de fois que désiré. Cliquez sur le bouton droit de la souris pour 
terminer l’action de l’outil. 

12. Outil d’infobulle (texte) : permet de créer une zone de texte avec un segment de ligne 
dépassant d’un coin de la zone de texte. Cela peut être utilisé pour « lier » du texte à un 
élément sur votre image. 

13. Outil de règle segmentée : permet de dessiner des lignes graduées non droites 
« ouvertes et segmentées ». Cliquez sur le bouton gauche de la souris en le maintenant 
enfoncé, et dessinez. Relâchez le bouton gauche pour définir un segment de ligne 
graduée. Répétez l’opération autant de fois que désiré. Cliquez sur le bouton droit de la 
souris pour terminer l’action de l’outil. La longueur de tous les segments de ligne gradués 
est indiquée à l’extrémité de la règle. Cet outil est utile pour une estimation approximative 
de la circonférence d’un objet ou d’un patient. 

14. Outil de rapporteur : dessine un angle sur l’écran et indique le degré de l’angle. Tout 
comme un rapporteur. 

15. Outil de règle orthogonale : offre deux (2) lignes graduées qui sont à angle droit l’une 
par rapport à l’autre. 

6.8.0 Suite 
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Mode de conception et menu contextuel (clic droit de la souris) 

En mode « User Annotation Design » (Conception d’annotations utilisateur), mais pas dans un 
mode de fonctionnement spécifique, il est possible de cliquer à droite sur la souris pour 
afficher un menu contextuel. Voir ci-dessous. 

 

De nombreux réglages spécifiques peuvent être effectués à partir de ces menus contextuels. 
 

 Remarque : notez que si un élément semble trop petit pour être lu ou vu correctement, 
l’utilisateur peut éventuellement le modifier à partir des menus contextuels présentés ci-
dessus. L’utilisateur peut également effectuer un zoom sur l’image à l’aide de l’outil Dynamic 
Zoom (Zoom dynamique). Cela agrandit l’image pour permettre à l’utilisateur de voir 
clairement toutes les annotations. 

 
 

Afficher – Masquer les annotations 
Le bouton Toggle Annotations (Basculer les annotations), présenté à la 
Figure 6.8.4, permet aux utilisateurs d’activer et de désactiver rapidement les 
annotations. Les annotations sont activées par défaut. Le bouton est situé dans le 
menu de droite, près du coin supérieur droit. 

6.8.0 Suite 
 

 
 

Figure 6.8.3 
Menu contextuel de la souris 
(clic droit) (uniquement en mode 
de conception des annotations 
de l’utilisateur) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 6.8.4 
Afficher/Masquer 
l’option pour les 
annotations utilisateur 
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Le menu « Help » (Aide), voir Figure 6.9.1, est situé dans la barre de menu supérieure et offre 
un accès rapide au « Manuel de l’utilisateur » du Faxitron Core et à la section « À propos de 
Vision ». Voir Figure 6.10.1. 

 
 
Le sous-menu « About Vision » (À propos de Vision) ouvre une boîte de dialogue qui affiche la 
version du logiciel Vision, les informations de droits d’auteur, la date et les informations sur le 
système. 

6.9.0 
Help (Aide) 
Figure 6.9.1 
Menu Help (Aide) 

 
 
 
6.10.0 
À propos du logiciel 
Vision 
Figure 6.10.1 
Boîte de dialogue About Vision 
(À propos de Vision) 
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